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はじめに
光を扱うことがすべてのはじまりです。

Unity は HD レンダーパイプライン（HDRP）を開発しましたが、これはクリエイター
がハイエンド PC やゲーム機などの性能を発揮し、新境地となるリアリティあふれ
るグラフィックスを生み出してクリエイターの描く構想を具現化する、ということ
を目的としたものでした。

このガイドでは、Unity をご利用のアーティストやクリエイターの方向けに、HDRP 
の物理ベースでのライティングの手法を紹介いたします。HDRP は Unity のリアル
タイムレンダリングの技術的な進歩を象徴するものであり、現実世界と同じような
ライティングを実現することができます。

みずみずしく生い茂る熱帯雨林の風景に自然な太陽光を当ててレンダリングしたり、
かと思えば都会のコンクリートジャングルではネオンのエミッシブライティングをふ
んだんに使って雰囲気を出したり…きっとあなたの作りたい雰囲気に合ったものもあ
るでしょう。HDRP なら、映画の撮影監督のようにシーンを彩ることが可能です。

見慣れた場所から幻想的な世界へプレイヤーを連れていけるようなゲーム環境を構
築できます。

さあ、HDRP と Unity を使ってみましょう！

Book of the Dead では、HDRP を使用して雰囲気のあるライティングを作成しています。

https://unity.com/ja/
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HDRP ライティングの概要
HDRP は、多様な機能で Unity の既存のライティングシステムを拡張し、
あなたの作るシーンのレンダリングをより現実世界のライティングに近
いものにしてくれます。

— 物理ベースのライト単位と露出：HDRP では、現実世界の光の強度と単位を使用し
ます。既知の光源の基準に合わせて、物理カメラを使用して露出を設定します。

— 高度なライティング：スポットライトやエリアライト用の新しい形状オプションを
使用して、ライトの配置を制御します。ライトレイヤーを使用して、特定のメッシュ
へのライトの影響を制限します。スクリーンスペースグローバルイルミネーション
や Screen Space Refraction などのリアルタイムエフェクトを適用できます。

— 空の景色：多彩な技術で自然な空を創造することができます。Physically Based 
Sky システムを使用して、惑星の大気のシミュレーションを手続き型で行ったり、
キューブマップのテクスチャーとして HDRI を適用したりできます。

— フォグ：フォグを使用して、シーンに奥行きや立体感を加えます。ボリュメトリッ
クを有効にして、フォグエフェクトをフォアグラウンドオブジェクトに組み込むこ
とで、シネマティックな光の軌跡をレンダリングできます。ボリュメトリックライ
トやシャドウをライトごとに管理して、ローカルボリュメトリックフォグコンポー
ネントを使用し、3D マスクテクスチャーでフォグの密度を微細に調整することが
可能です。

— ボリュームシステム：HDRP には直観的なシステムが採用されており、カメラの位
置や優先度に応じて、さまざまなライティングエフェクトや設定を遮断できます。
ボリュームを重ねたりブレンドしたりすることで、シーン内のあらゆる領域を非常
に細かく制御できます。

— ポストプロセッシング：HDRP のポストプロセッシングは、既存のボリュームシス
テムからうまく処理を行い、Volume オーバーライドにてまとめて管理されていま
す。アンチエイリアシング、トーンマッピング、カラーグレーディング、被写界深度、
その他のさまざまなエフェクトを追加できます。

— 高度なシャドウ：HDRP では、ビジュアルの美しさとパフォーマンスの兼ね合いを
考慮しつつもシャドウを制御することができる高度な機能を使用することができま
す。色合いやフィルタリング、解像度、メモリバジェット、更新モードを調整でき
ます。コンタクトシャドウや微細なシャドウを利用して、細かいディテールやさら
なる深みを際立たせましょう。

— 高度なリフレクション：さまざまな手法を使用して反射面をレンダリングできます。
リフレクションプローブでは、従来からあるリフレクションマッピング手法に加え、
フラットな表面向けのより高度なオプションが用意された平面リフレクションプ
ローブを使用できます。さらにスクリーンスペースリフレクション（SSR）によって、
深度バッファーを使用したリアルタイム手法を利用できます。

拡張性：HDRP は Unity のスクリプタブルレンダーパイプラインを基盤にしています。経
験豊富なテクニカルアーティストやグラフィックスプログラマーであれば、パイプライン
を標準機能以外にも拡張できます。

HDRP に触れるのがまったく初めてという方は、「HD レンダーパイプライン（HDRP）を
使ったゲーム制作」をご覧ください。

https://unity.com/ja/
https://docs.unity3d.com/Manual/ScriptableRenderPipeline.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=asset-links-gmg-artist-expansion&utm_content=hdrp-guide-ebook
https://learn.unity.com/project/up-and-running-with-hdrp
https://learn.unity.com/project/up-and-running-with-hdrp
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インストール
Unity 2020 LTS 以降では、常に検証済みの最新のグラフィックスコードを利用し
ていただけるよう、インストールファイルに HDRP パッケージが含まれています。
Unity の最新リリースをインストールすると、それに対応するバージョンの HDRP も
インストールされます。

HDRP グラフィックスパッケージを Unity の特定のリリースに関連付けることで、互
換性を確保しやすくなります。ただし、マニフェストファイルをオーバーライドする
ことで、HDRP のカスタムバージョンに切り替えることもできます。

システム要件

現在、HRDP に対応するターゲットプラットフォームは次のとおりです。

— DirectX 11 または DirectX 12 と Shader Model 5.0 対応の Windows および 
Windows ストア

— 最新のコンソール（Sony PlayStation 4 または Microsoft Xbox One 以上）

— Metal グラフィックス対応の MacOS（バージョン 10.13 以降）

— Vulkan 対応の Linux および Windows プラットフォーム

HDRP は、コンピュートシェーダー対応のコンソールおよびデスクトッププラット
フォームでのみ機能します。HDRP は、OpenGL または OpenGL ES デバイスには
対応していません。詳しくは、要件と互換性に関するドキュメントをご覧ください。

対応している VR プラットフォームおよびデバイスについては、「HD レンダーパイ
プラインでの VR」をご覧ください。

HDRP のパッケージバージョン 互換性のある Unity バージョン

12.x 2021.2

11.x 2021.1

10.x 2020.3 または長期サポート（このガイドで使用）

https://unity.com/ja/
https://docs.unity3d.com/Manual/upm-manifestPrj.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=asset-links-gmg-artist-expansion&utm_content=hdrp-guide-ebook
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@12.0/manual/System-Requirements.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=asset-links-gmg-artist-expansion&utm_content=hdrp-guide-ebook
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@12.0/manual/VR-Overview.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=asset-links-gmg-artist-expansion&utm_content=hdrp-guide-ebook
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@12.0/manual/VR-Overview.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=asset-links-gmg-artist-expansion&utm_content=hdrp-guide-ebook
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Unity Hub

Unity Hub を使用するのが、最も簡単に HDRP プロジェクトを設定する方法です。

まず、新しいプロジェクトを作成します。選択できるテンプレートの中から「3D 
Sample Scene (HDRP)」を選択します（旧バージョンの Hub での呼称は「High 
Definition RP」です）。これにより、サンプルのプリセットを含む HDRP パッケージ
がインポートされます。

 
「SampleScene」をロードします。次のようなシーンが表示されます。

「3D Sample Scene (HDRP)」テンプレートを選択します。

「3D Sample Scene」のプロジェクト設定

https://unity.com/ja/
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 1  Unity 2021.2/HDRP 12 では、「Window > Rendering > HDRP Wizard」にあります。

パッケージマネージャーのインストール

「3D Core template」を使用してプロジェクトを作成した場合は、以前までのビル
トインレンダーパイプラインが使用されることになります。パッケージマネージャー
（「Window > Package Manager」）からであれば HDRP に手動でプロジェクトを移
行することができます。

Unity Registry で「High Definition RP」パッケージを確認（または検索フィールド
を使用して確認）し、インストールします。

現行のプロジェクト設定で競合が発生した場合には、トラブルシューティングに対
応した「HDRP Render Pipeline Wizard」が表示されます（「Window > Render 
Pipeline > HDRP Render Pipeline Wizard」で開くこともできます）。1

「Configuration Checking」で「Fix All」をクリックするか、個別に「Fix」をクリック
してそれぞれの問題を修正していきます。このチェックリストは、非 SRP プロジェク
トからの移行時にも役立ちます。

パッケージマネージャーのインストール

https://unity.com/ja/
https://docs.unity3d.com/Manual/built-in-render-pipeline.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=asset-links-gmg-artist-expansion&utm_content=hdrp-guide-ebook
https://docs.unity3d.com/Manual/built-in-render-pipeline.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=asset-links-gmg-artist-expansion&utm_content=hdrp-guide-ebook
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ウィザードでの操作が完了すると、新規 HDRP パイプラインアセットの作成を促す
プロンプトが表示されます。対象のファイルはディスク上の、設定したこの特定のパ
イプライン設定を保存するためのものになります。「Create One」を選択して、新し
いレンダーパイプラインアセットを追加し、ファイルを割り当てます。

HDRP が適切に機能するようになると、「Configuration Checking」内のチェックボッ
クスがすべて緑色になり、背景環境の色調がはっきりと変わります。

なお、空白のプロジェクトを使って手動でインストールを行った場合は、「3D 
Sample Scene (HDRP)」がインポートされません。このガイドに出てくるサンプ
ルアセットを使用したい場合は、「3D Sample Scene」テンプレートを使用してく
ださい。

HDRP ウィザード

https://unity.com/ja/
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HDRP のサンプルシーン
Unity Hub から入手できる「3D Sample Scene」は、HDRP や物理ベースのライティ
ングの入門用テンプレートとしてのプロジェクトです。これは軽量なプロジェクトで
容量が 100 メガバイトにも満たないため、いつでも気軽にロードして参照すること
ができる優れた HDRP サンプルです。

このガイドでは、このプロジェクトを使用して、HDRP のさまざまな機能を説明し
ます。

小さな部屋がつながった構成になっており、ライティングの設定が異なる 3 種類の
エリアがあります。日光を表すディレクショナルライトは、現実世界と同じ強度であ
る 100,000 ルクスに設定されており、各部屋のライティング環境に合わせてカメラ
の露出が補正されています。

WASD キーとマウスを使用して、FPS Controller を移動させてみましょう。

「3D Sample Scene」の環境を表すワイヤーフレーム

https://unity.com/ja/
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— Room 1 は、頭上からの日光に照らされた円形の舞台です。デカールによって、
コンクリートの床に埃や水たまりが追加されています。

— Room 2 は、空の光からのボリュメトリックライトシャフトのほか、ガラスケー
ス内の木の高度なマテリアルが追加されています。

— Room 3 は、室内の人工照明とエミッシブマテリアルのディスプレイです。

HDRP の「3D Sample Scene」の詳細については、Unity テクニカルアーティスト
の Pierre Yves Donzallaz が執筆したこちらのブログ記事をご覧ください。このテン
プレートのシーンの詳細について説明しています。

このサンプルシーンは、HDRP の機能を説明するための軽量プロジェクトです。

「3D Sample Scene」は 3 つの部屋で構成されています。

https://unity.com/ja/
https://blog.unity.com/technology/explore-learn-and-create-with-the-new-hdrp-scene-template?utm_source=demand-gen&utm_medium=pdf&utm_campaign=asset-links-gmg-artist-expansion&utm_content=hdrp-guide-ebook
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その他の HDRP のサンプルコンテンツ

HDRP の「3D Sample Scene」には、参考になるプロジェクトが他にも用意されて
います。

「Auto Showroom」は本来ゲーミング向けのプロジェクトではありませんが、細部ま
で作り込まれた自動車がリアルにライティングされている様子を見ることができます。
インタラクティブなデモになっており、ステージのライト、車の塗装マテリアル、背
景を変更したりすることができます。このプロジェクトは Unity Hub で入手できます。

 

「Spaceship Demo」は Visual Effect Graph のデモを目的としたプロジェクトで
すが、SF 的な環境で多数の HDRP 機能が使用されています。このプロジェクトは、
Unity の GitHub リポジトリからダウンロードできます。

「Auto Showroom」テンプレート

「Spaceship」デモ

https://unity.com/ja/
https://github.com/Unity-Technologies/SpaceshipDemo
https://github.com/Unity-Technologies/SpaceshipDemo
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VR で HDRP を使用する場合は、「VR Alchemist Lab」が参考になります。このプロ
ジェクトでは、西洋の中世の小さな研究室の中で、インタラクティブなエフェクトが
使用されています。

映画のような絵作りやアニメーション映像の制作方法を学びたい場合は、「Cinematic 
Studio Sample」が参考になります。Mich-L という一風変わったショートムービー
を例に、スタイリッシュなレンダリングと写実的なレンダリングを組み合わせたシー
ン中のショットの設定方法やライティング方法を説明しています。

  

HD レンダーパイプラインについても学べますので、このようなプロジェクトをぜひ
参照してください。

「VR Alchemist Lab」デモ

Cinematic Studio Sample

https://unity.com/ja/
https://github.com/Unity-Technologies/VRAlchemyLab
https://assetstore.unity.com/packages/templates/tutorials/cinematic-studio-sample-192852?utm_source=demand-gen&utm_medium=pdf&utm_campaign=asset-links-gmg-artist-expansion&utm_content=hdrp-guide-ebook
https://assetstore.unity.com/packages/templates/tutorials/cinematic-studio-sample-192852?utm_source=demand-gen&utm_medium=pdf&utm_campaign=asset-links-gmg-artist-expansion&utm_content=hdrp-guide-ebook
https://unity.com/demos/mich-l-cinematics?utm_source=demand-gen&utm_medium=pdf&utm_campaign=asset-links-gmg-artist-expansion&utm_content=hdrp-guide-ebook
https://unity.com/demos/mich-l-cinematics?utm_source=demand-gen&utm_medium=pdf&utm_campaign=asset-links-gmg-artist-expansion&utm_content=hdrp-guide-ebook


15/83 | unity.com© 2021 Unity Technologies

Project Settings
「Project Settings」（「Edit > Project Settings」）の「Graphics」、「HDRP Default 
Settings」、「Quality」には、欠かせない基本設定が数点あります。

注：「HDRP Default Settings」は、Unity 2021.2/HDRP 12 以降では「HDRP Global 
Settings」になっています。

「Graphics」設定

最上部の「Scriptable Render Pipeline Settings」フィールドは、すべての HDRP 
設定が保管されるディスク上のファイルを意味します。

プロジェクトごとに複数のパイプラインアセットを使用できます。各アセットが別々
の設定ファイルだと考えてください。たとえば、各種ターゲットプラットフォーム
（Xbox、PlayStation など）の専用設定を保管するために使用したり、プレイヤーが
ランタイム時に切り替えることができる個別のビジュアルクオリティーレベルを示す
ために使用したりできます。

「3D Sample Scene」の場合、
まず「Settings」フォルダー
内に「HDRPHighQuality」、
「HDRPLowQuality」、
「HDRPMediumQuality」
の各パイプラインアセッ
トがあります。さらに、
「HDRPDefaultResources」
フォルダーには
「DefaultHDRPAsset」があり
ます。

Project Settings

「3D Sample Scene」には、低品質、中品質、高品質のパイプラインアセットが含まれています。

https://unity.com/ja/
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「Quality」設定

「Quality」設定では、任意のパイプラインアセットを、事前に定義した品質のレベル
へ一致させるようにすることができます。最上部の「Level」を選択して、特定のレ
ンダーパイプラインアセットを有効にします。これは「Rendering」オプションに表
示されます。

デフォルト設定をカスタマイズし
たり、品質レベルを追加したりし
た後で、追加のパイプラインアセッ
トとペアリングできます。

品質レベルは、パイプライン内で
アクティブ状態になっている特定
のビジュアル機能を表します。た
とえば、1 つのアプリケーション
に複数のグラフィックスレベルを
作成できます。ランタイム時には、
プレイヤーがハードウェアに合わ
せてアクティブな品質レベルを選
択できます。

「Quality/HDRP」のサブセクショ
ンで、実際のパイプライン設定を
編集できます。Project ウィンドウ
でパイプラインアセットを選択し、
インスペクターで設定を編集する
こともできます。

最上部でクオリティーレベルを選択し、パイプラインアセットを有効にします。

パイプラインアセットの編集

https://unity.com/ja/
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HDRP の最適化

パイプラインアセットで多くの機能を有効にすればするほど、消費リソースも増える点に
はご注意ください。一般的には、目標とする効果を実現するために必要なものだけを使用
するように、プロジェクトを最適化します。不要な機能がある場合は、オフにすることで、
パフォーマンスを高めてリソースを節約できます。

不要な場合は無効にしても問題ない機能の典型例は次のとおりです。

— 「HDRP Asset」：デカール、低解像度透明度、透明バックフェース /デプスプレパス /
デプスポストパス、SSAO、SSR、コンタクトシャドウ、ボリュメトリック、サブサー
フェススキャタリング、ディストーション

— カメラの「Frame Settings」（メインカメラ、リフレクションのような統合エフェク
トなどに使用するカメラ、またはカスタムした効果に対して使用している追加カメ
ラ）：屈折、ポストプロセス、ポストプロセス後、トランスミッション、リフレクショ
ンプローブ、平面リフレクションプローブ、ビッグタイルプレパス

HDRP Default Settings

「HDRP Default Settings」セクション（Unity 2021.2/HDRP 12 では「HDRP Global Settings」）で、
プロジェクト開始時に有効にする機能の基本設定を指定します。この設定は、カメラの位置
や優先度に応じて、ローカル設定によってオーバーライドされます（後述のボリュームを 
参照）。

「Global Settings」は、最上部のフィールドで定義されている個別のパイプラインアセット
に保存されます。ここでデフォルトのレンダリングおよびポストプロセスのオプションを
設定します。

HDRP 機能の有効化

プロジェクトを進めている時に、場合によっては、「HDRP Default Settings」へ戻っ
て、特定の機能を切り替えてオンまたはオフに設定することが必要になる場合もありま
す。一部の機能は、「Default Settings」内の対応するチェックボックスを明示的にオン
にしておかないとレンダリングされることはありません。用途ごとに応じて、ある設定は
「Volume Profiles」に出ていたり、また別の機能は「Frame Settings」に表示されてい
たりするので、その点についてはご注意ください。

HDRP のさまざまな機能について調べる際は、「Project Settings」の右上にある検索フィー
ルドを活用しましょう。表示対象が関連するパネルのみに絞られるようになり、検索用語
が強調表示されます。

 

「HDRP Default Settings」で機能を有効にしても、アクティブにならない場合もあります。
検証するために、現時点で品質レベルとして選択されているパイプラインアセットの位置
は必ず把握しておくようにしましょう。そこでも、対応するオプションをオンにしておき
ます。HDRP 機能を利用するには、グローバル設定とローカル設定の両方で有効にする必
要があります。

HDRP 機能の検索

https://unity.com/ja/
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フォワードレンダリング
とディファードレンダリ
ング
パイプラインアセットで HDRP 設定を指定する場合、通常は「Rendering」の「Lit 
Shader Mode」を開きます。ここでは、「Deferred」、「Forward」、または「Both」を
選択できます。これらは、パイプラインによるジオメトリのレンダリングおよびライティ
ング方法に関連する一連の処理であるレンダリングパスを表します。

デフォルトの HDRP 設定の変更

レンダリングパスのカスタマイズ

「Lit Shader Mode」で「Forward」または
「Deferred」を選択し、デフォルトのレンダリン
グパスを設定します。

HDRP は柔軟性が高いので「Both」を選択する
こともできます。このオプションを利用した場合
はほとんどのレンダリングにレンダリングパスを 
1 つ使用することとなり、カメラごとにそのパス
をオーバーライドできるようになります。ただし、
この方法では GPU メモリの使用量が多くなってし
まいます。ほとんどのケースでは、「Forward」か
「Deferred」のいずれかを選択するのが有効です。

— デフォルトですべてのカメラを対象にする
には、「HDRP Default Settings」に移動
し、「Default Frame Settings」を確認し
ます。ここでは、「Camera」、「Baked or 
Custom Reflection」、または「Realtime 
Reflections」を対象に設定できます。

 「Rendering」 グ ル ー プ で、「Lit Shader 
Mode」のレンダリングパスを設定します。

— 特定のカメラでデフォルト設定をオーバーラ
イドするには、「Custom Frame Settings」
をオンにします。

 続いて、「Rendering」グループで、「Lit 
Shader Mode」のレンダリングパスをオー
バーライドして変更します。

カメラのカスタムフレーム設定の変更

https://unity.com/ja/
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レンダリングパスに関する詳細

こうしたレンダリングパスの仕組みを理解し、「Lit Shader Mode」がパイプライン
のその他の設定にどのように影響するのかを確認することをおすすめします。

フォワードレンダリング

フォワードレンダリングでは、グラフィックスカードによって画面上のジオメトリが
頂点に分割されます。これらの頂点は、さらにフラグメントやピクセルに分割され、
それが画面にレンダリングされて最終的な画像が作成されます。

各オブジェクトは 1 度に 1 つずつグラフィックス API に渡されます。フォワードレ
ンダリングには、各ライトのコストが伴います。シーン内のライトが増えると、レン
ダリングの所要時間も長くなります。

 
フォワードレンダリングでは、別々のパスでライトを描画します。同一のゲームオブ
ジェクトに複数のライトを当てている場合は、ライトやオブジェクトが多数存在して
いると、大幅なオーバードローが生じ、動作が遅くなることがあります。

フォワードレンダリングパス

https://unity.com/ja/


20/83 | unity.com© 2021 Unity Technologies

従来のフォワードレンダリングとは異なり、HDRP では、フォワードレンダラーに
効率面の改良が加えられています。たとえば、オブジェクトマテリアルごとに 1 つ
のパスで、複数のライトをまとめてカリングし、レンダリングします。ただし、そ
れでもプロセスのコストは比較的大きくなります。パフォーマンスに問題がある場
合は、ディファードシェーディングを使用することをおすすめします。

ディファードシェーディング

HDRP では、オブジェクト単位でのライティング計算が発生しないディファード
シェーディングも使用できます。ディファードシェーディングでは負荷の大きいレン
ダリングを後の段階に遅らせ、2 つのパスを使用します。

1 つ目のパスである G-buffer ジオメトリパスでは、Unity がゲームオブジェクトを
レンダリングします。このパスは、複数のタイプのジオメトリプロパティーを取得
し、テクスチャーのセットに保管します（ディフューズ色およびスペキュラー色、
サーフェスのスムースネス、オクルージョン、法線など）。

2 つ目のパスのライティングパスでは、Unity が G-buffer の完了後にシーンのライ
ティングをレンダリングします。つまり、シェーディングを遅らせます。ディファー
ドシェーディングパスはピクセルごとに反復され、個々のオブジェクトではなく、
バッファーを基準にライティング情報を計算します。

各レンダリングパスの技術的な違いの詳細については、HDRP に関するドキュメント
のフォワードレンダリングとディファードレンダリングをご覧ください。

ディファードシェーディングパス

ディファードシェーディングでは、オブジェクトではなくバッファーにライティングを適用します。それぞれのパスが、最終的
にレンダリングされる画像に反映されます。

https://unity.com/ja/
https://docs.unity3d.com/Manual/RenderTech-DeferredShading.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=asset-links-gmg-choose-unity-for-multiplatform&utm_content=optimize-game-performance-2020-lts-ebook?utm_source=demand-gen&utm_medium=pdf&utm_campaign=asset-links-gmg-artist-expansion&utm_content=hdrp-guide-ebook
https://docs.unity3d.com/Manual/RenderTech-DeferredShading.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=asset-links-gmg-choose-unity-for-multiplatform&utm_content=optimize-game-performance-2020-lts-ebook
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@11.0/manual/Forward-And-Deferred-Rendering.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=asset-links-gmg-artist-expansion&utm_content=hdrp-guide-ebook
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アンチエイリアシング
「Lit Shader Mode」のレンダリングパスは、アンチエイリアシングを使用してレン
ダリングからギザギザのエッジを取り除く方法に影響します。HDRP では、制作の
ニーズに合わせて複数のアンチエイリアシング手法を使用できます。

マルチサンプルアンチエイリアシング（MSAA）

マルチサンプルアンチエイリアシング（MSAA）は、PC ゲームで一般的なアンチエ
イリアシング手法です。個々のポリゴンのエッジを滑らかにする高性能ハードウェア
向けの手法で、Unity ではフォワードレンダリングを使用する場合のみ機能します。
最新の GPU は、2x、4x、8x MSAA サンプルに対応しています。

アクティブなパイプラインアセットで、「Lit Shader Mode」を「Forward Only」に
設定します。続いて、「Multisample Anti-aliasing Quality」で、「MSAA 2x」、「MSAA 
4x」、または「MSAA 8x」を選択します。値が大きいほどアンチエイリアシングの
質が上がりますが、動作は遅くなります。

これは、カメラビューでズームインしたときにより顕著になります。

MSAA のクオリティー設定

元のシーン

MSAA 設定を適用した画像

https://unity.com/ja/
https://en.wikipedia.org/wiki/Multisample_anti-aliasing
https://en.wikipedia.org/wiki/Graphics_processing_unit
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ポストプロセスでのアンチエイリアシング

ポストアンチエイリアシングを次のように設定して、ポストプロセスの技術で設定した
カメラにアンチエイリアシングを適用することもできます。

— Temporal Anti-aliasing（TAA）では、過去と現在のフレームからの情報を組み
合わせ、現在のフレーム内のジャギーを取り除きます。この設定を使用するため
には、モーションベクトルを有効にする必要があります。大半の場合 TAA は良い
成果を生み出しますが、状況によって（コントラストのあるサーフェスの前面で
ゲームオブジェクトが高速で移動した場合など）ゴースト上のアーティファクト
が発生することがあります。HDRP10 では、一般的な TAA アーティファクトを削
減するための改良が加えられています。Unity の実装ではゴーストの発生が抑制さ
れ、シャープネスが改善されたほか、他のソリューションで見られるちらつきが
防止されています。

— Fast Approximate Anti-aliasing（FXAA）
は、ハイコントラストの領域間のピクセ
ルをブレンドするスクリーンスペースア
ンチエイリアシングアルゴリズムです。
比較的高速で、大規模な演算能力も不要
ですが、画像の全体的なシャープネスは
落ちる場合があります。

— Subpixel Morphological Anti-aliasing
（SMAA）では、画像内の境界を検出し
てから、ブレンドする特定のパターンを
検出します。これによって、FXAA より
シャープな結果が生成されます。フラッ
トスタイルやカートゥーン調のスタイ
ル、クリーンなアートスタイルに適して
います。

ディファードシェーディングを使用する際は、カメラのポストアンチエイリアシングを調整します。

次の制約事項にご注意ください。

— MSAA は、シーンのジオメトリをテク
スチャーに保管するディファードシェー
ディングの G-buffer では利用できませ
ん。そのため、ディファードシェーディ
ングでは、いずれかのポストプロセスで
のアンチエイリアシング手法（後述）を
使用する必要があります。

— MSAA では、ポリゴンのエッジのエイ
リアシングのみを処理するため、シャー
プなスペキュラーライトが届く特定のテ
クスチャーやマテリアルに対するエイリ
アシングについては防ぐことができませ
ん。これが問題になる場合は、MSAA と
別で、ポストプロセスでのアンチエイリ
アシング手法（右側）を組み合わせる必
要があります。

ポストプロセスのアンチエイリアシング：FXAA、SMAA、TAA の各設定の結果を比較。

 注：ポストプロセスでのアンチエイリアシングとマルチサンプルアンチエイリアシングを組み合わせる際は、レンダリング
コストに注意してください。いつでもビジュアルクオリティーとパフォーマンスのバランスがとれるように、プロジェクト
は常に最適化を心がけるようにしましょう。

https://unity.com/ja/
https://en.wikipedia.org/wiki/Jaggies
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@7.1/manual/Motion-Vectors.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=asset-links-gmg-artist-expansion&utm_content=hdrp-guide-ebook
https://en.wikipedia.org/wiki/Spatial_anti-aliasing
https://en.wikipedia.org/wiki/Spatial_anti-aliasing
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ボリューム
HDRP ではボリュームフレームワークを使用します。このシステムでは、シーンを分
割し、カメラの位置に合わせて特定の設定や機能を有効化できます。たとえば、この 
HDRP テンプレートレベルは 3 つに分かれており、それぞれに独自のライティング
設定があります。その形で、各部屋も別々のボリュームが内包しています。

 
ボリュームは、ボリュームコンポーネントが含まれたプレースホルダーオブジェクト
に過ぎません。ボリュームは、「GameObject > Volume」メニューから、プリセッ
トを選択することで作成できます。または、適切なコンポーネントを含めたゲームオ
ブジェクトを手動で作成します。

ボリュームコンポーネントは任意のゲームオブジェクトに追加できるため、階層か
ら見つけるのが困難になる場合があります。ライトエクスプローラー（「Window > 
Rendering > Light Explorer > Volumes」）を使用すると、ロードされているシーン
のボリュームを見つけやすくなります。このインターフェースを使用して手早く調整
することができます。

それぞれにライティング条件が異なるスペースをボリュームが覆っています。

プリセットを使用してボリュームオブジェクトを作成

ライトエクスプローラーには、開いているシーン内のすべてのボリュームが一覧表示されます。

https://unity.com/ja/
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@12.0/manual/Volumes.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=asset-links-gmg-artist-expansion&utm_content=hdrp-guide-ebook
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ローカルとグローバル

コンテキストに合わせて、ボリュームコンポーネントの「Mode」を「Global」また
は「Local」に設定します。

グローバルボリュームは、境界のない「汎用」ボリュームとして使用できます。その
場合、シーン内のすべてのカメラに影響します。HDRP テンプレートシーンでは、レ
ベル全体の HDRP 設定のベースラインが VolumeGlobal によって定義されます。

ローカルボリュームでは、設定を適用する限定的なスペースを定義します。コライダー
コンポーネントを使用して境界を決定します。コライダーによって FPS プレイヤー
コントローラーなどの物理ボディの動きが妨げられないようにするには、「IsTrigger」
を有効にします。

このテンプレートシーンでは、
各部屋に、グローバル設定をオー
バーライドする BoxCollider を
含むローカルボリュームがあり
ます。
 
Room 2 には、ガラスケースの
横の中央の明るい場所に小さな
球面ボリュームがあります。同
様に、Room 3 には、入口の通
路と、つり下げの照明の下の椅
子があるエリアに、より小さな
ボリュームがあります。

グローバル Volume オーバーライド

各部屋に、コライダーが「IsTrigger」に設定されたローカルボリュームが
あります。

https://unity.com/ja/
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SampleScene では、ローカルボリュームによって「White Balance」、「Exposure」、
「Fog」がオーバーライドされます。明示的にオーバーライドされない要素は、すべ
てグローバルのデフォルト設定にフォールバックされます。

シーン内でカメラが動く際は、グローバル設定をオーバーライドするローカルボリュー
ムにプレイヤーコントローラーが接触するまでは、グローバル設定が適用されます。

パフォーマンスに関するヒント

ボリュームは大量に使用しないようにしてください。各ボリュームの評価（ブレン
ディング、立体化、オーバーライドの計算など）には、CPU コストが伴います。

 
ボリュームプロファイル

ボリュームコンポーネント自体には、実際のデータは含まれません。その代わり、ボ
リュームコンポーネントはボリュームプロファイルを参照します。これは、シーンを
レンダリングするための HDRP 設定を含むディスク上の ScriptableObject です。新
しいボリュームプロファイルを作成するには、「Profile」フィールドで、「New」ま
たは「Clone」ボタンを使用します。

保存済みの別のプロファイルに切り替えることもできます。ボリュームプロファイル
をファイルとして使用することで、以前の設定を再利用したり、ボリューム間でプロ
ファイルを共有したりしやすくなります。

再生モード中にボリュームプロファイルに加えられた変更内容は、再生モードを終了
した後も残ります。

特殊なライティング条件では小さいボリュームを使用します。

「Profile」フィールドでボリュームプロファイルを切り替えるか、新しく作成します。

https://unity.com/ja/
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@11.0/manual/Volume-Profile.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=asset-links-gmg-artist-expansion&utm_content=hdrp-guide-ebook
https://docs.unity3d.com/Manual/class-ScriptableObject.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=asset-links-gmg-artist-expansion&utm_content=hdrp-guide-ebook
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Volume オーバーライド

各ボリュームプロファイルでは最初、一連のプロパティーがデフォルト値に設定され
ています。この値を編集するには、Volume オーバーライドを使用し、個々の設定を
カスタマイズします。たとえば、Volume オーバーライドでは、ボリュームのフォグ、
プロセッシング、露出を変更できます。

ボリュームプロファイルを設定したら、「Add Override」をクリックし、プロファイ
ル設定をカスタマイズします。フォグのオーバーライドは次のようになります。

Volume オーバーライドの各プロパティーでは、左側にチェックボックスがあり、そ
こで対象のプロパティーの編集を有効化できます。ボックスを無効のままにすると、
HDRP では、ボリュームの初期値が使用されます。

各ボリュームオブジェクトには、複数のオーバーライドを設定できます。それぞれの
オーバーライドで、必要に応じてプロパティーを編集できます。左上の「All」また
は「None」のショートカットを使用すると、オンとオフを一括で切り替えることが
できます。

Volume オーバーライドとしてのフォグの例

https://unity.com/ja/
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@11.0/manual/Volume-Profile.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=asset-links-gmg-artist-expansion&utm_content=hdrp-guide-ebook
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@12.0/manual/Volume-Components.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=asset-links-gmg-artist-expansion&utm_content=hdrp-guide-ebook
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オーバーライドのワークフロー

オーバーライドの追加は、HDRP の重要なワークフローです。プログラミングからの
継承という概念を理解していれば、Volume オーバーライドも理解しやすくなります。

上位レベルのボリューム設定は、下位レベルのボリュームのデフォルト設定として使
用されます。ここでは、HDRP のデフォルト設定がグローバルボリュームに渡されま
す。それがローカルボリュームの「ベース」として使用されます。

グローバルボリュームによって、HDRP のデフォルト設定がオーバーライドされます。
次に、ローカルボリュームによってグローバルボリュームがオーバーライドされます。
「Priority」、「Weight」、「Blend Distance」（概要は後述）を使用して、ボリューム
の重複に起因する競合を解消します。

特定のボリュームコンポーネントの現在の値をデバッグするには、「Rendering 
Debugger」の「Volume」タブを使用します。

HDRP のドキュメントで、完全な Volume オーバーライドのリストを確認できます。

Volume オーバーライドを使用して HDRP 機能を追加

ボリュームのデバッグ

https://unity.com/ja/
https://en.wikipedia.org/wiki/Inheritance_(object-oriented_programming)
https://en.wikipedia.org/wiki/Inheritance_(object-oriented_programming)
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@12.0/manual/Volume-Components.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=asset-links-gmg-artist-expansion&utm_content=hdrp-guide-ebook
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ブレンディングと優先度

レベルごとに複数のボリュームが必要な場合もあるため、HDRP ではボリューム間の
ブレンドが可能になっています。これにより、ボリューム間の遷移がスムーズになり
ます。

ランタイム時、HDRP はカメラ位置を基に、最終的な HDRP 設定に影響するボリュー
ムを判断します。

「Blend Distance」によって、ボリュームのコライダー外にどの程度離れたらフェード
オンまたはフェードオフを開始するかを指定します。「Blend Distance」の値を「0」に
設定すると即座に遷移が開始されます。正の値を設定すると、カメラが指定された範囲
内に入ったときに Volume オーバーライドによってブレンディングが開始されます。

ボリュームフレームワークは柔軟性が高く、必要に応じてボリュームとオーバーライ
ドを組み合わせることができます。同一スペース内に複数のボリュームが重複してい
る場合、「Priority」に基づいて、優先されるボリュームが決定されます。この値が大
きいほど優先度が高くなります。

通常は、あいまいになるのを防ぐために「Priority」を明示的に設定します。明示的
に設定しない場合、「Priority」が同じであれば作成された順番で優先順が決定されま
すが、それによって予期しない結果が生じることがあります。

「Blend Distance」を使用して、ボリューム周辺の遷移ゾーンを定義します。

ローカルボリュームが重複する場合は、「Blend Distance」、「Weight」、「Priority」を使用します。

https://unity.com/ja/
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露出
HDRP は、現実世界のライティングモデルを使用して各シーンをレンダリングしま
す。そのため、従来の写真術で使われてきたプロパティーと類似するプロパティー
が多数あります。

露出値を理解する

露出値（EV）は、カメラのシャッタースピードと F 値（レンズの開口部または絞り
のサイズ）の組み合わせによって決まる数値です。明度を最適化し、シャドウとハイ
ライトの両方でディテールを高精度に捉えるためには、露出を適切に設定する必要が
あります。露出を適切に設定しないと、画像の露出過多や露出不足が生じ、期待する
結果が得られなくなります。

HDRP での露光範囲は、多くの場合、以下の範囲内に収まります。

露出値が大きくなるほどカメラに入る光が少なくなり、より明るい状況に適します。
露出値 13 から 16 の範囲は、晴天の日中の屋外に適しています。一方、暗く、月が
ない夜空には、露出値 -3 から 0 が適しています。

露出オーバー、露出アンダー、適正露出の比較。 

月のない夜から、明るい晴天日までの露出範囲

https://unity.com/ja/
https://en.wikipedia.org/wiki/Shutter_speed
https://en.wikipedia.org/wiki/F-number
https://en.wikipedia.org/wiki/Exposure_(photography)
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実際のカメラ設定で、次のようなさまざまな要素を変更し、露出値を調整できます。

— シャッタースピード：画像センサーを光にさらす時間

— F 値：絞り /レンズ開口部のサイズ

— ISO：フィルム /センサーの感度

写真家の間では、これは「露出の三角形」と呼ばれています。Unity では、現実のカ
メラと同様、これらの数値をさまざまな形で組み合わせて同じ露出値を実現できます。

HDRP では、すべての露出値が EV100 で表現されます。これにより、感度は 100 
International Standards Organisation（ISO）フィルムの感度に固定されます。

露出の三角形

https://unity.com/ja/
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@12.0/manual/Physical-Light-Units.html#EV?utm_source=demand-gen&utm_medium=pdf&utm_campaign=asset-links-gmg-artist-expansion&utm_content=hdrp-guide-ebook
https://en.wikipedia.org/wiki/Film_speed
https://en.wikipedia.org/wiki/Film_speed
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露出値の計算式

次の計算式によって、実際の露出値が計算されます。

これは底を 2 とする進数スケールです。露出値が 1 単位増加すると、レンズに入る
光の量が半分に減少します。

HDRP では、実際の画像の露出に合わせることができます。カメラやスマートフォン
でデジタル写真を撮影するだけで、その画像からメタデータを取得し、F 値、シャッ
タースピード、ISO を特定できます。

そのうえで、上記の計算式によって露出値を計算します。Exposure オーバーライド
（後述）と同じ値を使用すると、レンダリングされる画像は、現実の画像と同じ露出
になります。

この方法を使うことで、レベルのライティングを設定する際にデジタル写真を参照情
報として使用できます。その画像を完全に再現することが目的とは限りませんが、実
際の写真に合わせることによって、勘に頼ることなくライティングを設定できます。

露出の計算式

デジタル写真の Exif データを基に露出を合わせます。

https://unity.com/ja/
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Exposure オーバーライド

HDRP では、露出は Volume オーバーライドです。ローカルボリュームまたはグロー
バルボリュームに追加することで利用可能なプロパティーを確認できます。

「Mode」ドロップダウンで、「Fixed」、「Automatic」、「Automatic Histogram」、
「Curve Mapping」、「Physical Camera」のいずれかを選択できます。

「Compensation」では、露出を変更、調整できます。通常はこれを利用して小さな
調整を加え、レンダリングされた画像を上下にわずかに「ストップ」させます。

「Fixed」モード

「Fixed」モードでは、露出値を手動で設定できます。

「Fixed Exposure」スライダーの目盛りが参考になります。
また、右側のアイコンをクリックするとプリセットのド
ロップダウンが表示されます（「Sunlit Scene」の 13 から
「Moonless Scene」の -2.5 まで）。フィールドの値を任意
の数値に設定することもできます。

「Fixed」モードはシンプルですが、柔軟性に劣ります。通
常は、ライティングが比較的均一で、1 つの露出値で対応で
きるボリュームやシーンを使用する場合に効果的です。
 
「Automatic」モード

「Automatic」モードでは、画面上の明度の範囲に応じて露出が動的に設定されます。
この設定は、人間の目が暗さの変化に適応し、黒と認識されるものを再定義する仕組
みと非常に似ています。

「Automatic」モードは、さまざまなライティングの状況下で有効ですが、カメラが
非常に暗い場所や非常に明るい場所を向いたときに、意図せず画像の露出過多や露出
不足が生じる場合もあります。

露出レベルを適切な範囲内に収めるためには、「Limit Min」と「Limit Max」を使用
します。テストプレイを行って、レベル全体で上限値が適切な露出の範囲内に収まっ
ているか確認してください。

「Metering Mode」をマスクオプションと組み合わせると、フレーム内のどの部分を
自動露出に使用するか決定できます。

「Fixed」モードの露出

「Fixed」モードの露出のプリセット

https://unity.com/ja/
https://en.wikipedia.org/wiki/Stopping_down
https://en.wikipedia.org/wiki/Adaptation_(eye)
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「Adaptation」モードでは、暗い場所と明るい場所の間をカメラが遷移する際に、自
動露出をどのように変化させるかを制御します。スピードを調整するオプションを利
用します。人間の目と同じように、非常に暗いエリアから非常に明るいエリアにカメ
ラが移動すると（またはその逆）、一時的にどこを向いているのかわからなくなる場
合があります。

 
「Metering Mode」のオプション

「Automatic」、「Automatic Histogram」、「Curve Mapping」モードでは、「Metering 
Mode」を使用して、フレーム内のどの部分を露出の計算に使用するかを制御します。
「Metering Mode」は次のように設定できます。

— 「Average」：フレーム全体を使用して露出を測定します。

— 「Spot」：画面の中央部のみを使用して露出を測定します。

— 「Center Weighted」：画面の中央部にあるピクセルを優先的に使用し、フレー
ムの端に向かうにつれて使用率を減らしていきます。

— 「Mask Weighted」：指定した画像（「Weight Texture Mask」）を使用して、露
出を測定する際にどのピクセルを最も重視するかを決めます。

— 「Procedural Mask」：手続き型で生成されたテクスチャーを基に露出を評価し
ます。オプションを使用して、中心の位置、半径、ぼかし具合を変更できます。

「Automatic」モードの露出

「Metering Mode」の「Spot」と「Center Weighted」

https://unity.com/ja/
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Automatic Histogram

「Automatic Histogram」モードは、「Automatic」モードをさらに発展させたもの
です。露出設定時に画像のヒストグラムを計算し、最も暗いピクセルと最も明るい
ピクセルを無視します。

 
露出の計算から非常に暗いピクセルと非常に明るいピクセルを排除することで、フ
レーム内に極端に明るいピクセルや暗いピクセルがある場合でも、安定した露出を得
られます。これにより、発光が強いサーフェスや黒いマテリアルがあったとしても、
レンダリング結果で深刻な露出過多や露出不足が生じることはありません。

「Histogram Percentages」設定を使用すると、ヒストグラム内の指定したパーセン
テージ範囲に含まれないデータをすべて無視できます（たとえば、ヒストグラムの左
端と右端から、最も明るいピクセルと最も暗いピクセルを除外することができます）。

「Curve Remapping」を使用すると、露出曲線もリマップできます（後述の「Curve 
Mapping」を参照）。

「Automatic Histogram」モード

「Automatic Histogram」では、ヒストグラム中央部にあるピクセルを基に露出を計算します。

https://unity.com/ja/
https://en.wikipedia.org/wiki/Image_histogram
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Curve Mapping

「Curve Mapping」モードは、「Automatic」モードのもう 1 つのバリエーションです。

この設定では、曲線の X 軸は現在の露出を表し、Y 軸はターゲットとする露出を表
します。露出曲線のリマップによって、非常に高精度な結果を生成できます。

「Curve Mapping」モード

曲線を変えて露出を調整します。

https://unity.com/ja/
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@10.5/manual/Override-Exposure.html#AutomaticProperties?utm_source=demand-gen&utm_medium=pdf&utm_campaign=asset-links-gmg-artist-expansion&utm_content=hdrp-guide-ebook
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Physical Camera

写真に詳しい方は、「Physical Camera」モードを使用すると、カメラのパラメーター
を設定しやすいかもしれません。

Exposure オーバーライドの「Mode」を「Physical Camera」に切り替えてから、
「Main Camera」を確認します。

「Physical Camera」を有効にします。インスペクターに次のプロパティーが表示さ
れます。

露出関連で重要なのは、「ISO」（感度）、「Aperture」（F 値）、「Shutter Speed」です。
参照用の写真に合わせる場合は、画像の Exif データから適切な設定をコピーします。
または、こちらの表を参考にすると、F 値とシャッタースピードを基に露出値を推測
できます。

「Physical Camera」モード

カメラの「Physical Camera」プロパティー

https://unity.com/ja/
https://docs.unity3d.com/Manual/PhysicalCameras.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=asset-links-gmg-artist-expansion&utm_content=hdrp-guide-ebook
https://en.wikipedia.org/wiki/Exif
https://en.wikipedia.org/wiki/Exposure_value#EV_as_an_indicator_of_camera_settings
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「Physical Camera」のその他のパラメーター

露出とは無関係ですが、「Physical Camera」のその他のプロパティも、現実世界の
カメラの属性に合わせる助けになります。

たとえば、Unity（および他の多数の 3D アプリケーション）では通常、有効視野
（FOV）を使用して、カメラがワールド内を一度に撮影できる範囲を決定します。

しかし、実際のカメラでは、有効視野はセンサーのサイズとレンズの焦点距離によっ
て決まります。直接有効視野を設定するのではなく、「Physical Camera」の設定を
使用すると、実際のカメラのデータの「Sensor Type」、「Sensor Size」、「Focal 
Length」を入力できます。データを入力すると、それに対応する有効視野の値が自
動的に算出されます。

実際の写真に合わせて露出を設定す
るには、その画像ファイルに含まれ
るカメラのメタデータを利用しま
す。Windows と macOS の両方で、
デジタル画像から Exif データを読
み取ることができます。そのうえで、
対象のフィールドをバーチャルカメ
ラにコピーできます。

注：場合によっては、メタデータか
らカメラのメーカーとモデル名を確
認し、そのメーカーのウェブサイト
で正確なセンサーのサイズを調べる
必要があります。こちらの記事には、
一般的な画像センターのフォーマッ
トの推定が記載されています。

下にあるパラメーターのいくつか
は、有効視野ボリュームに影響しま
す。「Blade Count」、「Curvature」、
「Barrel Clipping」を使用して、カ
メラの絞りの形状を変更できます。
このパラメーターは、これによって、
被写界深度ボリュームコンポーネン
トによって生じる「ぼけ」の見え方
に影響します。

焦点距離、センサーサイズ、有効視野の関係

物理カメラのパラメーターを使用して絞りの形状を設定します。5 枚羽根絞りの場合、五角形（左）または円形（右）のぼけを
表現できます。

https://unity.com/ja/
https://docs.unity3d.com/Manual/PhysicalCameras.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=asset-links-gmg-artist-expansion&utm_content=hdrp-guide-ebook
https://en.wikipedia.org/wiki/Field_of_view
https://en.wikipedia.org/wiki/Image_sensor_format
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@12.0/manual/Post-Processing-Depth-of-Field.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=asset-links-gmg-artist-expansion&utm_content=hdrp-guide-ebook
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ライト
HDRP には、シーン内のイルミネーションの制御に役立つさまざまなタイプのライト
や形状が用意されています。

ライトのタイプ

Unity の他のレンダーパイプラインと同様に、次のタイプのライトを利用できます。

— ディレクショナル：無限遠に位置する光源からの光のような特性を持ちます。
強度が落ちない完全な平行光線です。ディレクショナルライトは、多くの場合、
日光として使用されます。一般的に、屋外のシーンでは、これがキーとなるラ
イトです。

— スポット：現実世界のスポットライトに似ており、円錐、ピラミッド、ボック
スといった形状があります。スポットは、前方 Z 軸に沿って、円錐 /ピラミッ
ド形状のエッジに向かって落ちていきます。

— ポイント：空間内のある 1 点からすべての方向に光を放つ全方向性ライトです。
ランプやキャンドルなどの放射光源に適しています。

— Area：特定の形状（矩形、チューブ、またはディスク）のサーフェスから光を
投影します。エリアライトは、窓や蛍光灯のような、中央部の強度が均一であ
る面的な光源においての使用に適しています。

「Range」を使用して、スポットライト、ポイントライト、エリアライトをどのよう
に減衰させるかを調整できます。多くの HDRP ライトは、現実世界の光源と同じよ
うに、逆 2 乗の法則に従って減衰します。

https://unity.com/ja/
https://en.wikipedia.org/wiki/Inverse-square_law
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形状

スポットライトとエリアライトには、各ライトの減衰方法を制御するために独自の形状
が追加されています。

HDRP のスポットライトでは、3 つの形状を使用できます。

— Cone（円錐）:：1 点から円錐形に広がる光を投影します。「Outer Angle」（角度）
と「Inner Angle」（パーセンテージ）を使用して、円錐形の形と角度減衰を調整
します。

— Pyramid（ピラミッド）：1 点から四角錐型に広がる光を投影します。「Spot 
Angle」と「Aspect Ratio」を使用して四角錐の形状を調整します。

— Box（ボックス）：矩形のボリューム全体へ均一に光を投影します。X サイズと 
Y サイズによって基部となる長方形を定めて、「Range」によって Y 次元を調整
します。この光は、「Range Attenuation」がオンになっていなければ減衰しな
いようになっているので、ボックスの範囲内で日光のシミュレーションなども行
うことができます。

HDRP のエリアライトでは、3 つの形状を使用できます。

— Rectangle（矩形）：矩形の形状からローカルの正の Z 方向に、定義された
「Range」まで光を投影します。

— Tube（チューブ）：1 本の線から全方向に、定義された「Range」まで光を投影
します。このライトは「Realtime Mode」でのみ使用できます。

— Disc（ディスク）：ディスク型の形状からローカルの正の Z 方向に、定義された
「Range」まで光を投影します。このライトは「Baked Mode」でのみ使用できます。

HDRP のスポットライトの形状

HDRP のエリアライトの形状

https://unity.com/ja/
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色と温度

HDRP のすべてのタイプのライトに、ライトの外観を定義する「Emission」プロパ
ティーがあります。

「Light Appearance」を「Color」に切り替えると、RGB カラーを指定できます。
または、これを「Filter and Temperature」に変更し、より物理的に正確なデータ
を入力できます。

色温度では、ケルビン度に基づいて色を設定します。詳しくは、ライティングと露出
のチートシートをご覧ください。

別の色を追加してフィルターのように作用させることで、別の色相を使ってライトに
色を付けることもできます。これは、現実の写真撮影でカラージェルフィルターを使
用する方法と似ています。

ケルビン温度で表された色温度

「Emission」の「Light Appearance」プロパティーを変更

各ライトに追加のプロパティーがあります。

https://unity.com/ja/
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@12.0/manual/Light-Component.html#Emission?utm_source=demand-gen&utm_medium=pdf&utm_campaign=asset-links-gmg-artist-expansion&utm_content=hdrp-guide-ebook
https://docs.unity3d.com/ScriptReference/Color.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=asset-links-gmg-artist-expansion&utm_content=hdrp-guide-ebook
https://en.wikipedia.org/wiki/Color_temperature
https://en.wikipedia.org/wiki/Color_gel
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追加のプロパティー

インスペクターのプロパティーの右上にある「More Options」ボタンの下にも、高
度なコントロールがいくつか用意されています。このボタンをクリックすると追加の
コントロールが表示されます。

「Affect Diffuse」、「Affect Specular」などのトグルがあります。たとえば、カット
シーンや映画のようなライティングでは、明るいハイライトを制御するライトと、よ
りソフトなディフューズライトを生成するライトを分離することができます。

「Intensity Multiplier」を使用して、ライトの元の強度の値を変更せずに全体的なラ
イトの強度を調節することもできます。複数のライトを一括で明るくしたり暗くした
りするのに便利です。

ディフューズライティングとスペキュラーライティングの設定を細かく調整できます。

https://unity.com/ja/
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ライトレイヤー

HDRP では、ライトレイヤーを使用して、ライトの影響範囲をシーン内の特定のメッ
シュに限定できます。これは、ライトコンポーネントと MeshRenderer に関連付け
ることができる LayerMask になります。

ライトのプロパティーで、「More Options」ボタンをクリックします。「General」
に「Light Layer」ドロップダウンが表示されます。ライトに関連付ける LayerMask 
を選択します。

次に、「Rendering Layer Mask」を使用して MeshRenderer を設定します。対応す
る LayerMask 上のライトのみがメッシュに影響します。これは、光漏れを解消し、
意図した対象のみに確実にライトを当てるために欠かせない機能です。また、カット
シーンのライティングを設定するワークフローにこの機能を組み込むことで、映画的
な演出でキャラクターだけに専用のライトが当たるようにすることができます。

「Light」プロパティーで、「More Items」メニュー（☰）から「Show 
Additional Properties」を選択します。「General」に「Light Layer」ドロッ
プダウンが表示されます。ライトに関連付ける LayerMask を選択します。

「Light Layer」の選択

https://unity.com/ja/
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@12.0/manual/Light-Layers.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=asset-links-gmg-artist-expansion&utm_content=hdrp-guide-ebook
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たとえば、建物内部のライトが意図せず壁を貫通し、屋外に出るのを防ぎたい場合は、
屋内用と屋外用のライトレイヤーを設定します。この機能を使えば、ライトの構成を
細かく制御できます。

ライトレイヤーを設定するには、「HDRP Default Settings」にアクセスします。
「Layers Names」セクションでは、「Light Layer 0」の文字列名を「7」に設定で
きます。

ライトのプロパティーに関する全体のリストを含めて、この詳細については、ライト
コンポーネントに関するドキュメントをご覧ください。

「Rendering Layer Mask」を設定し、特定のライトのみがメッシュに適用されるようにします。

「HDRP Default Settings」の「Layers Names」

https://unity.com/ja/
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@12.0/manual/Light-Component.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=asset-links-gmg-artist-expansion&utm_content=hdrp-guide-ebook
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@12.0/manual/Light-Component.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=asset-links-gmg-artist-expansion&utm_content=hdrp-guide-ebook
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物理ベースのライト単位
と強度
HDRP では、物理ベースのライト単位（PLU）を光の強度の測定に使用します。これ
は、カンデラ、ルーメン、ルクス、ニトなど、現実世界での照度の SI 測定単位と一
致しています。PLU では、正確性を確保するため、Unity の 1 単位は 1 メートルに等
しいことが前提になっていることにご注意ください。

単位

物理ベースの光の単位には、光束と照度の両方の単位が含まれる場合があります。光
束とは光源から放出される光の総量であり、照度とはオブジェクトに当たる光の総量
を指します（単位面積あたりの光束で表されるのが一般的）。

商用のライティングや写真の分野では、用途によって使用される単位が異なる場合
があります。そのため、Unity では互換性を確保するために、次のように複数の物
理ベースのライト単位に対応しています。

— カンデラ：1 単位が、1 本のろうそくの
光束に相当します。燭（燭光）などの呼
称も一般的です。

— ルーメン：SI の光束単位で、1 ステラジ
アン（立体角）に対する 1 カンデラの光
束と定義されます。ルーメンは、商用電
球の仕様によく見られます。Unity のス
ポット、ポイント、エリアライトで使用
します。

— ルクス：1 平方メートルのエリアに 
1 ルーメンの光を放出する光源が、照度 
1 ルクスに相当します。現実世界で光を
測定する際は、ルクスを読み取るのが一
般的です。通常、Unity のディレクショ
ナルライトではこの単位を使用します。

— ニト：1 平方メートルあたり 1 カンデラ
に相当する照度単位です。ディスプレイ
デバイスや LED パネル（テレビやモニ
ターなど）では、明るさをニト単位で測
定するのが一般的です。

— EV100：EV100、つまり露出値 100 ISO フィ
ルムに相当する強度を使用します（前述
の露出値の計算式を参照）。露出を上げ
ると、対数的な計算により、ライティン
グが倍増します。

ライティングと露出のレベルに関するガイダンス

https://unity.com/ja/
https://en.wikipedia.org/wiki/International_System_of_Units
https://en.wikipedia.org/wiki/SI
https://en.wikipedia.org/wiki/Steradian
https://en.wikipedia.org/wiki/Steradian
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現実世界の光源を再現するには、技術仕様に記載されている単位に切り替え、適切な
光束または輝度を設定します。HDRP によって物理ベースのライト単位に合わせるこ
とで、勘に頼らずに強度を設定できます。

アイコンをクリックし、「Exterior」、「Interior」、「Decorative」、「Candle」のいず
れかのプリセットを選択します。特定の値に合わせる必要がない場合は、このような
設定から始めることをおすすめします。

ライティングと露出の一般的な値

以下のチートシートには、現実世界の一般的な光源の色温度の値とライトの強度がま
とめられています。また、さまざまなライティングシナリオに合った露出値も紹介さ
れています。

一般的なイルミネーションの値をまとめた詳細な表については、物理ベースのライト
単位に関するドキュメントをご覧ください。

IES プロファイルとクッキー

IES プロファイルを使用すると、ポイント、スポット、エリアライトの減衰を、現実
世界の光に近い形で再現できます。これは、特定の製造元の仕様をライトのパターン
に適用するライトクッキーのように機能します。IES プロファイルを使用すれば、ラ
イトのリアリティをさらに高めることができます。

IES プロファイルを「Assets > Import New Asset」からインポートします。インポー
ターによって、適切な強度でライトのプレハブが自動的に作成されます。続いて、プ
レハブをシーンビューまたは階層にドラッグし、色温度を調整します。

IES プロファイルのソースの例は次のとお
りです。

実際の製造元
— Philips
— Lithonia Lighting
— Efficient Lighting Systems
— Atlas
— Erco
— Lamp
— Osram

アーティストのソース
— Renderman

IES プロファイルのインポーターの詳細に
ついては、ドキュメントをご覧ください。

さまざまなライトに適用される IES プロファイル

IES プロファイルとインポート設定

https://unity.com/ja/
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@12.0/manual/Light-Component.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=asset-links-gmg-artist-expansion&utm_content=hdrp-guide-ebook
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@12.0/manual/Override-Exposure.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=asset-links-gmg-artist-expansion&utm_content=hdrp-guide-ebook
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@12.0/manual/Physical-Light-Units.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=asset-links-gmg-artist-expansion&utm_content=hdrp-guide-ebook
https://en.wikipedia.org/wiki/Illuminating_Engineering_Society
https://docs.unity3d.com/Manual/Cookies.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=asset-links-gmg-artist-expansion&utm_content=hdrp-guide-ebook
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@12.0/manual/IES-Importer.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=asset-links-gmg-artist-expansion&utm_content=hdrp-guide-ebook
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@12.0/manual/IES-Importer.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=asset-links-gmg-artist-expansion&utm_content=hdrp-guide-ebook
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@12.0/manual/Light-Component.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=asset-links-gmg-artist-expansion&utm_content=hdrp-guide-ebook
https://www.usa.lighting.philips.com/support/support/literature/photometric-data
https://lithonia.acuitybrands.com/resources/technical-downloads/photometricdownloads
http://elslighting.com.au/downloads/ies-files/
https://www.atlaslightingproducts.com/ies-files
https://www.erco.com/download/en
https://www.lamp.es/en/products_1791?pd-type=indoor
https://www.osram.com/cb/
https://renderman.pixar.com/ies-profiles
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@12.0/manual/IES-Importer.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=asset-links-gmg-artist-expansion&utm_content=hdrp-guide-ebook
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環境ライティング
現実世界では、光は反射して散乱します。空と地面が環境の光へ影響しています。こ
れは大気と地表の間で無差別に跳ね返って散った光子が、最終的に人の目に入ってい
くからです。

HDRP では、「Visual Environment」のオーバーライドを使用して、シーンの空と環
境光を定義できます。

「Ambient Mode: Dynamic」を使用して、空のライティングを、「Visual Environment」
の「Sky > Type」に表示される現在のオーバーライドに設定します。または、 
「Ambient Mode: Static」を使用する場合は、「Lighting」ウィンドウの「Environment」
タブの空の設定がデフォルトになります。

他の光源を無効にしている場合でも、SampleScene は「Visual Environment」の環
境光に照らされます。

太陽のキーとなるライトを追加することで、シーンの全般的なイルミネーションが決
まります。環境光は、シャドウエリアを照らして、不自然に暗くならないようにする
のに役立ちます。

HDRP には、空を生成する手法が 3 種類あります。「Type」を「HDRI Sky」、
「Gradient Sky」、または「Physically Based Sky」のいずれかに設定します。続
いて、「Sky」メニューから適切なオーバーライドを追加します。

「Visual Environment」の空を適用すると、バーチャルワールド全体が、明るく照ら
された巨大な球体で囲まれたような状態になります。この球体の色付きのポリゴンが、
空、地平線、地面からの全般的なライトを提供します。

環境ライティングのみ：日光のディレクショナルライトが無効ですが、 
空にはアンビエントライトが残っています。

直接的な日光と環境ライティングの組み合わせ

https://unity.com/ja/
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@12.0/manual/Override-Visual-Environment.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=asset-links-gmg-artist-expansion&utm_content=hdrp-guide-ebook
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HDRI Sky

「HDRI Sky」では、ハイダイナミックレンジの写真から作成したキューブマップを使用
して空を表現できます。HDRI については、無料のソースや低コストのソースがオンラ
インに多数あります。出発点としては、アセットストアにある Unity HDRI Pack が適
しています。挑戦してみたいと思っている方のために、自分で HDRI を撮影するための
ガイドも用意しています。

HDRI アセットをインポートしたら、「HDRI Sky」のオーバーライドを追加し、「HDRI 
Sky」アセットをロードします。「Distortion」、「Rotation」、「Update Mode」のオプ
ションを調整することもできます。

空はイルミネーションのソースになるため、「Intensity Mode」を指定してから、対応
する「Exposure/Multiplier/Lux」の値を選択して環境ライティングの強度を制御しま
す。強度と露出の値の例については、前述のライティングと露出のチートシートを参照
してください。

HDRI Sky

キューブマップとして球体の内部に適用された HDRI Sky

https://unity.com/ja/
https://en.wikipedia.org/wiki/High-dynamic-range_imaging
https://assetstore.unity.com/packages/essentials/beta-projects/unity-hdri-pack-72511??utm_source=demand-gen&utm_medium=pdf&utm_campaign=asset-links-gmg-artist-expansion&utm_content=hdrp-guide-ebook
https://docs.unity3d.com/2017.4/Documentation/uploads/ExpertGuides/High_Dynamic_Range_Imaging_HDRI.pdf?utm_source=demand-gen&utm_medium=pdf&utm_campaign=asset-links-gmg-artist-expansion&utm_content=hdrp-guide-ebook
https://docs.unity3d.com/2017.4/Documentation/uploads/ExpertGuides/High_Dynamic_Range_Imaging_HDRI.pdf?utm_source=demand-gen&utm_medium=pdf&utm_campaign=asset-links-gmg-artist-expansion&utm_content=hdrp-guide-ebook
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「Gradient Sky」
では、「Top」、
「Middle」、
「Bottom」の色を
ブレンドします。Gradient Sky

「Visual Environment」で「Gradient 
Sky」を選択すると、カラーランプを
使用して背景の空を近似します。続い
て、「Gradient Sky」のオーバーライ
ドを追加します。「Top」、「Middle」、
「Bottom」を使用して、グラデーショ
ンの色を指定します。

カラーランプを「Gradient Diffusion」
とブレンドし、ライティングの強さの
「Intensity」を調整します。

Physically Based Sky

グラデーションより大幅にリアルさを
高めたい場合は、「Physically Based 
Sky」のオーバーライドが有効です。
これにより、ミー散乱やレイリー散乱
などの現象を再現した空が手続き型で
生成されます。この空では、大気を通っ
て分散する光のシミュレーションが行
われ、自然な空の配色が再現されます。
「Physically Based Sky」では、正確な
シミュレーションを行うためにディレ
クショナルライトが必要です。

「Physically Based 
Sky」のオーバーラ
イド

手続き型で生成された空（「Fountainebleau」デモより）

https://unity.com/ja/
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@12.0/manual/Override-Gradient-Sky.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=asset-links-gmg-artist-expansion&utm_content=hdrp-guide-ebook
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@12.0/manual/Override-Gradient-Sky.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=asset-links-gmg-artist-expansion&utm_content=hdrp-guide-ebook
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@12.0/manual/Override-Physically-Based-Sky.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=asset-links-gmg-artist-expansion&utm_content=hdrp-guide-ebook
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@12.0/manual/Override-Physically-Based-Sky.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=asset-links-gmg-artist-expansion&utm_content=hdrp-guide-ebook
https://en.wikipedia.org/wiki/Mie_scattering
https://en.wikipedia.org/wiki/Rayleigh_scattering
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フォグと大気散乱
スモーク、フォグ、もやは、映画的な画面作りの定番のツールです。奥行きや立体感
を加えてライティングを演出したり、趣のある雰囲気を創出したりするのに役立ちま
す。HDRP では、フォグを使用して同様の効果を実現できます。

不透明度は、オブジェクトとカメラの距離に応じます。フォグを利用すると、カメラ
のファークリップ面を非表示にして、遠くにあるジオメトリをシーンにブレンドする
こともできます。

「Base Height」と「Maximum Height」を使用して、低い位置に漂うフォグを表現します。

https://unity.com/ja/
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グローバルフォグ

HDRP では、「Fog」のオーバー
ライドとしてグローバルフォグ
を実装しています。この例では、
カメラとの距離とワールド空間
の高さに合わせて、フォグが急
激にフェードしていきます。

シーン内のボリュームで「Fog」のオーバーライドを設定します。「Base Height」では、
一定の濃いフォグが上方向に向かうにつれ、薄くなり始める境目を指定します。この
値を上回ると、「Maximum Height」に到達するまで、フォグの密度が急激にフェー
ドしていきます。

同様に、「Fog Attenuation Distance」と「Max Fog Distance」では、カメラから
距離が離れるにつれ、フォグをどのようにフェードさせるのかを設定します。「Color 
Mode」は、「Constant Color」と既存の「Sky Color」のどちらかに設定します。

「Volumetric Fog」を有効にすると、大気散乱のシミュレーションが行われます。
「Lighting」の「Frame Settings」（カメラの下か、「HDRP Default Settings」内）
で、「Fog」と「Volumetrics」がオンになっていることを確認します。また、「HDRP 
Pipeline Asset」で「Volumetric Fog」も有効にします。

「Volumetric Fog Distance」では、カメラのニアクリップ面からボリュメトリック
ライティングバッファーの背部までの距離（メートル単位）を設定します。これによ
り、大気中に浮遊物質が満たされ、範囲内のゲームオブジェクトが部分的に隠れます。

「Fog」のオーバーライド

Fog Attenuation Distance

ボリュメトリックフォグは、より正確に前景のジオメトリを保持します。

https://unity.com/ja/
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@12.0/manual/Override-Fog.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=asset-links-gmg-artist-expansion&utm_content=hdrp-guide-ebook
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ボリュメトリックライティング

ボリュメトリックライティングによって、日没時の雲の背後や木々の間から射す薄明
光線など、印象的な太陽光線をシミュレーションでレンダリングできます。

それぞれのライトコンポーネント（エリアライト以外）に、「Volumetrics」グルー
プがあります。「Enable」をオンにしてから、「Multiplier」と「Shadow Dimmer」
を設定します。「Real-time」または「Mixed Mode」のライトを使用すると、ボリュ
メトリックフォグ内に「薄明光線」が生成されます。「Multiplier」で強度を調整し、
「Shadow Dimmer」を使用して、シャドウを投影するサーフェスがライトを遮る具
合を設定します。

このサンプルシーンの Room 2 では、空の光とボリュメトリックフォグが使用され
ています。ガラスケースのフレームによって、天井からの太陽光線に伴うボリュメト
リックシャドウが形成されています。「Shadow Dimmer」と「Multiplier」の値を高
めると、エフェクトが強くなります。

「Light」コンポーネントの「Volumetrics」

天井のスポットライトに適用されたボリュメトリックライティング

https://unity.com/ja/
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@12.0/manual/Volumetric-Lighting.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=asset-links-gmg-artist-expansion&utm_content=hdrp-guide-ebook
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@12.0/manual/Volumetric-Lighting.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=asset-links-gmg-artist-expansion&utm_content=hdrp-guide-ebook
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@12.0/manual/Volumetric-Lighting.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=asset-links-gmg-artist-expansion&utm_content=hdrp-guide-ebook
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ローカルボリュメトリックフォグ

HDRP では、「Fog」のオーバーライドよりも細
かいフォグエフェクトが必要な場合に、「Local 
Volumetric Fog」（HDRP 12 より前のバージョンで
の呼称は「Density Volume」コンポーネント）を
利用できます。

これはボリュームシステムの外にある別個の
コンポーネントです。メニューから「Local 
Volumetric Fog」のゲームオブジェクトを作成
（「GameObject > Rendering > Local Volumetric 
Fog」）するか、「Hierarchy」を右クリックします
（「Rendering > Local Volumetric Fog」）。

これにより、フォグが満ちたバウンディングボッ
クスが生成されます。サイズ、軸のコントロール、
ブレンディング /フェーディングのオプションを
調整します。

デフォルトではフォグは一様ですが、3D テクス
チャーを「Density Mask Texture」サブセクショ
ンの「Texture」フィールドに適用できます。これ
により、ユーザーはより柔軟にフォグの外観をコ
ントロールできます。パッケージマネージャーの
「Local Volumetric 3D Texture Samples」から
サンプルをダウンロードするか、ドキュメントの
手順に即して密度マスクを作成します。

アニメーションの「Scroll Speed」を追加し、
「Tiling」を調整します。以上で、ボリュメトリッ
クフォグを徐々にシーン内に描画できます。

注：HDRP では、ローカルボリュメトリックフォ
グをボクセル化してパフォーマンスを高めます。
ただし、ボクセル化によって外観が非常に粗くな
る場合があります。エイリアシングを低減する
ためには、「Density Mask Texture」を使用し、 
「Blend Distance」を上げてフォグのエッジを滑ら
かにします。

「Local Volumetric Fog」コンポーネント

ボリュメトリックライティングが、ボリュメトリックフォグのエリアを印象的に
照らしています。

ローカルボリュメトリックフォグはバウンディングボックスに表示されます。

「Local Volumetric 3D Texture Samples」の「Density Mask Texture」

https://unity.com/ja/
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@12.0/manual/Local-Volumetric-Fog.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=asset-links-gmg-artist-expansion&utm_content=hdrp-guide-ebook
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@12.0/manual/Local-Volumetric-Fog.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=asset-links-gmg-artist-expansion&utm_content=hdrp-guide-ebook
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@12.0/manual/Local-Volumetric-Fog.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=asset-links-gmg-artist-expansion&utm_content=hdrp-guide-ebook
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@12.0/manual/Local-Volumetric-Fog.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=asset-links-gmg-artist-expansion&utm_content=hdrp-guide-ebook
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シャドウ
暗闇がなければ光を認識することはできません。シーン内に適切に配置されたシャド
ウは、ライティングそのものと同じくらい趣を生み出し、シーンに奥行きや立体感を
加えることができます。HDRP には、シャドウを微調整し、レンダリングが単調にな
るのを防ぐための機能が多数あります。

シャドウマップ

シャドウは、シャドウマッピングという手法でレンダリングされます。この手法で
は、ライトの視点からの深度の情報がテクスチャーに保管されます。

「Light」コンポーネントの「Shadows」サブセクションで、シャドウマッピングの
「Update Mode」と「Resolution」を変更できます。解像度と更新頻度の設定値が
高くなるほど、リソースの消費が大きくなります。

ライトごとのシャドウ設定

https://unity.com/ja/
https://en.wikipedia.org/wiki/Shadow_mapping
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シャドウカスケード

ディレクショナルライトの場合は、シャドウマップがシーンの大部分を覆うため、
透視エイリアシングと呼ばれる問題が生じることがあります。カメラから近い位
置にあるシャドウマップのピクセルは、遠くにあるものよりも、ギザギザで粗く
なります。

透視エイリアシングと粗いシャドウ

シャドウカスケードによって透視エイリアシングが低減されます。

https://unity.com/ja/
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Unity では、カスケードシャドウマップ
を使用してこの問題を解決しています。
この手法では、カメラの錐台を、それ
ぞれにシャドウマップがある複数の
ゾーンに分割します。これにより、透
視エイリアシングのエフェクトが低減
されます。

HDRP では、「Shadows」のオーバー
ライドで、シャドウカスケードをより
詳細に制御できます。ボリュームごと
のカスケード設定を使用して、それぞ
れのカスケードの始点と終点を微調整
できます。

「Show Cascades」ボタンを切り替え
て、カスケードの分割をより簡単に可
視化できます。ある程度の調整を加え
ることで、透視エイリアシングを最小
限に抑えることができます。

コンタクトシャドウ

シャドウマップは、特に 2 つの
メッシュサーフェスが結合する
目立ちやすいエッジで、小さな
ディテールを取り込めないこと
がよくあります。HDRP では、
「Contact Shadows」 の オ ー
バーライドを使用して、こうし
たコンタクトシャドウを生成で
きます。

コンタクトシャドウはスクリー
ンスペースエフェクトの一種
で、フレーム内の情報を基に計
算を行います。フレーム外のオ
ブジェクトは、コンタクトシャ
ドウには影響しません。コンタ
クトシャドウは、画面上のフッ
トプリントが小さいシャドウの
ディテールに使用します。

 「Frame Settings」で「Contact 
Shadows」を有効にします。
「Lighting Quality Settings」
の「Pipeline Asset」で、
「Sample Count」を調整する
こともできます。

「Contact Shadows」のオーバーライド

「Shadows」のオーバーライド

シャドウカスケード
では、カメラの錐台
を複数のゾーンに分
割します。各ゾーン
にそれぞれシャドウ
マップがあります。

https://unity.com/ja/
https://docs.unity3d.com/Manual/shadow-cascades.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=asset-links-gmg-artist-expansion&utm_content=hdrp-guide-ebook
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@12.0/manual/Override-Shadows.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=asset-links-gmg-artist-expansion&utm_content=hdrp-guide-ebook
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「Show Cascades」をクリックすると、カスケードの分割を可視化できます。

Micro shadows

HDRP では、小さなシャドウのディテールをマテリアルに広げることができます。
「Micro Shadows」は、法線マップとアンビエントオクルージョンマップを使用し
て、メッシュのジオメトリそのものを使用せずに、非常に細かいサーフェスのシャ
ドウをレンダリングします。

「Micro Shadows」のオーバーライドをシーン内のボリュームに追加し、「Opacity」
を調整します。「Micro Shadows」を利用できるのはディレクショナルライトのみです。

シャドウの厚み、クオリティー、フェードの設定を調整します。

微細なシャドウによって、植え込みのコントラストが強められています。

「Micro Shadows」のオーバーライド

https://unity.com/ja/
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リフレクション
リフレクションは、ゲームオブジェクトと周囲の環境を統合するのに役立ちます。通常、
リフレクションは、滑らかで光沢のあるサーフェスに関連付けますが、滑らかではな
いマテリアルの場合でも、PBR ワークフローで適切なリフレクションを受ける必要が
あります。HDRP では、次のようなさまざまな手法でリフレクションを生成できます。

— スクリーンスペースリフレクション

— リフレクションプローブ

— スカイリフレクション

各リフレクションタイプは、リソースの消費が大きくなる場合があるため、ユースケー
スに合わせて最適な手法を選択してください。複数のリフレクション手法がピクセル
に適用される場合、各リフレクションタイプの効果がブレンドされます。「Influence 
Volume」という名前のバウンディングサーフェスを使用して 3D スペースを分割し、
リフレクションを受け取るオブジェクトを指定してください。

スクリーンスペースリフレクション

スクリーンスペースリフレクションでは、深度とカラーバッファーを使用してリフレ
クションを計算します。そのため、反射するのはカメラビューに入っているオブジェ
クトのみになり、画面上の位置によっては適切にレンダリングされない場合がありま
す。光沢のある床や濡れた平面サーフェスが、スクリーンスペースリフレクションを
受け取る対象として適しています。

スクリーンスペースリフレクションでは、フレーム外のオブジェクトはすべて無視さ
れるため、それがエフェクトの制限となる場合があります。

「Influence Volume」では、リフレクションプローブによってリフレクションを生成する場所を指定します。

https://unity.com/ja/
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「Lighting」の「Frame Settings」（「HDRP Default Settings」またはカメラの「Custom 
Frame Settings」）で、「Screen Space Reflection」が有効になっていることを確認し
てください。続いて、「Screen Space Reflection」のオーバーライドをボリュームオブ
ジェクトに追加します。

スクリーンスペースリフレクションを表示するには、マテリアルのサーフェス
を「Minimum Smoothness」の値以上にする必要があります。比較的粗いマテ
リアルに SSR を適用したい場合は、この値を引き下げます。ただし、「Minimum 
Smoothness」のしきい値を下げると、計算コストが大きくなる場合があります。
スクリーンスペースリフレクションの効果をピクセルに適用できなかった場合は、
HDRP はリフレクションプローブを使用する方法にフォールバックします。

「Quality」ドロップダウンを使用して、既定数の「Max Ray Steps」を選択します。 
「Max Ray Steps」が多くなると、クオリティーは上がりますが、コストは大きくな
ります。すべてのエフェクトと同様、パフォーマンスとビジュアルクオリティーのバ
ランスをとることが大事です。

「Screen Space Reflection」のオーバーライド

スクリーンスペースリフレクション

https://unity.com/ja/
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リフレクションプローブ

リフレクションプローブを使用すると、画像ベースの手法でリフレクションが生成さ
れます。プローブは、周囲全方向の球面ビューを取り込み、その結果をキューブマッ
プのテクスチャーに保管します。シェーダーは、そのキューブマップを使用してリフ
レクションを再現します。

各シーンに複数のプローブを適用し、結果をブレンドできます。以降、ローカライズ
されたリフレクションが環境内のカメラの動きに合わせて変化します。

各プローブの「Type」を「Baked」または「Real-time」に設定します。

— 「Baked」のプローブは、静的環境でキューブマップのテクスチャーを 1 回だ
け処理します。

— 「Real-time」プローブは、ランタイム時にエディターではなくプレイヤー内に
キューブマップを作成します。そのためリフレクションが静的オブジェクトに
限定されなくなりますが、リアルタイム更新によってリソース消費が大きくな
る場合があることに注意してください。

「Influence Volume」によって、ゲームオブジェクトがリフレクションを受け取る 3D 
の境界を指定します。一方「Capture Settings」では、リフレクションプローブによっ
てキューブマップのスナップショットを取得する方法をカスタマイズできます。

「Reflection Probe」コンポーネント

https://unity.com/ja/
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平面リフレクションプローブ

平面リフレクションプローブでは、サーフェスのスムースネスを考慮して、反射する
平面サーフェスを再現できます。鏡や光沢のある床を表現するのには最適です。

平面リフレクションプローブは、通常のリフレクションプローブとの共通点が多数あ
りますが、処理が若干異なります。環境をキューブマップとして取り込むのではなく、
プローブの鏡面で反射されたカメラのビューを再現します。

その後、生成された反射像が 2D RenderTexture として保存されます。この画像が矩
形のプローブの境界に描画され、平面リフレクションを生み出します。

平面リフレクションプローブでは、平面にカメラを反射させることで、鏡面画像を取り込みます。

3 種類のマテリアルに適用された平面リフレクションプローブ

https://unity.com/ja/
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@12.0/manual/Planar-Reflection-Probe.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=asset-links-gmg-artist-expansion&utm_content=hdrp-guide-ebook
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スカイリフレクション

近傍のリフレクションプローブの影響を受けないオブジェクトは、スカイリフレク
ションにフォールバックします。

リフレクション階層

HDRP では質の高いリフレクションが得られるよう、各ピクセルの精度を最大限に高
め、他の手法とブレンドすることができる手法を使用しています。HDRP では、加重
優先度を基に、3 つのリフレクション方法（SSR、リフレクションプローブ、空）を
チェックします。リフレクションを評価する際のこのシーケンスは、リフレクション
階層と呼ばれます。

1 つのピクセルで、ある手法によってリフレクションを特定できなかった場合は、そ
の次の手法にフォールバックします。つまり、スクリーンスペースリフレクションは
リフレクションプローブにフォールバックし、その後スカイリフレクションにフォー
ルバックします。

「Reflection Probe」プロパティーで、「Influence Volume」を設定することが大事で
す。これを設定しないと、不適切なスカイリフレクションからライトが漏れる場合が
あります。

これは、SampleScene の Room 3 で顕著です。いずれかの「Reflection Probe」を
無効にするか、「Influence Volume」を変更すると、リフレクションが強制的に空に
フォールバックされます。これにより、HDRI の明るい空が、強力なリフレクション
によってシーンよりも過剰に強調されます。

リフレクション階層の確認の詳細については、ドキュメントの「HDRP のリフレクショ
ン」に関するページをご覧ください。

リフレクションプローブは周囲の部屋を映し、スカイリフレクションはグラデーションのある空を映します。

https://unity.com/ja/
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@12.0/manual/Reflection-in-HDRP.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=asset-links-gmg-artist-expansion&utm_content=hdrp-guide-ebook
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@12.0/manual/Reflection-in-HDRP.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=asset-links-gmg-artist-expansion&utm_content=hdrp-guide-ebook
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@12.0/manual/Reflection-in-HDRP.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=asset-links-gmg-artist-expansion&utm_content=hdrp-guide-ebook
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@12.0/manual/Reflection-in-HDRP.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=asset-links-gmg-artist-expansion&utm_content=hdrp-guide-ebook
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リフレクションプロキシボリューム

リフレクションプローブのキャプチャーポイントは固定されており、リフレクション
プローブの近くのカメラ位置と一致することはほとんどないため、生成されたリフレ
クションで、透視のシフトが目立つ場合があります。それにより、リフレクションが
環境になじんでいないように見える場合があります。

リフレクションプロキシボリュームは、これを部分的に修正するのに役立ちます。カ
メラ位置を基に、プロキシボリューム内でより正確にリフレクションを再投影します。

リフレクションプロキシボリュームでは、部屋のワールド空間の位置に合わせてキューブマップを再投影します。

Room 3 の天井でリフレクションプローブを無効にすると、不要なライトの漏れが生じます。

https://unity.com/ja/
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リアルタイムライティン
グエフェクト
HDRP は、ボリュームシステムを通じて、いくつかのリアルタイムライティングエ
フェクトを利用することもできます。ローカルまたはグローバルボリュームを選択
してから、「Add Override > Lighting」で適切なエフェクトを追加します。

スクリーンスペースアンビエントオクルージョン

アンビエントオクルージョンでは、近接した溝や穴、サーフェスの影のシミュレー
ションを行います。アンビエントライトが遮断されるエリアは、陰影が付いている
ように見えます。

「Ambient Occlusion」のオーバーライド

「Auto Showroom」プロジェクトでのアンビエントオクルージョンの可視化

https://unity.com/ja/
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Unity のライトマッパーを使用して静的ジオメトリのアンビエントオクルージョンを
ベイクできますが、HDRP によって、リアルタイム処理を行う スクリーンスペース
リフレクション を追加で利用できます。これはスクリーンスペースエフェクトなの
で、フレーム内の情報のみが生成されるエフェクトに影響します。SSAO では、カメ
ラの有効視野外のオブジェクトはすべて無視されます。

「Lighting」の「Frame Settings」で、「Screen Space Refraction」を有効にしま
す。続いて、ローカルまたはグローバルボリュームで「Add Override」をクリックし、
「Lighting > Ambient Occlusion」を選択します。

スクリーンスペースグローバルイルミネーション

スクリーンスペースグローバルイルミネーション（SSGI）では、画面の深度とカラー
バッファーを使用して、反射するディフューズライトを計算します。ライトマッピン
グで間接光を静的レベルのジオメトリのサーフェスにベイクする方法と似ています
が、SSGI では光子がサーフェスに衝突して反射する際に色やシェーディングが変化
する仕組みのシミュレーションをさらに正確に行うことができます。

このサンプルシーンの Room 2 では、SSGI を有効にすることで、揺れる木の葉の緑
が反射光として壁面に映っていることがわかります。

「Screen Space Global Illumination」のオーバーライド

スクリーンスペースグローバルイルミネーションによって、植物の葉の反射光をリアルタイムで描画しています。

https://unity.com/ja/
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カメラの有効視野外のオブジェクトはグローバルイルミネーションには影響しないた
め、フレームバッファーに依存する他のエフェクトと同様、画面端が問題になります。

SSGI は、「Lighting」の「Frame Settings」で有効にします。パイプラインアセッ
トの「Lighting」セクションでも有効にする必要があります。

注：スクリーンスペースグローバルイルミネーションを含む Unity 2021.2 以降を使
用することをおすすめします。HDRP 12 では、SSGI のクオリティーが大幅に改善さ
れています。

Screen Space Refraction

「Screen Space Refraction」オーバーライドは、大気よりも密度が高いメディア
を通過する光の動きのシミュレーションを行う際に役立ちます。HDRP の Screen 
Space Refraction では、深度とカラーバッファーを使用して、ガラスなどの透明な
マテリアルを透過する光の屈折を計算できます。

HDRP/Lit シェーダーでこのエフェクトを有効にするには、マテリアルの「Surface 
Type」が「Transparent」になっていることを確認します。

続いて、「Transparency Inputs」で「Refraction Model」と「Index of Refraction」
を選択します。中空でないオブジェクトの場合、「Refraction Model」には「Sphere」
を使用します。中空のオブジェクトについては「Thin」（泡など）または「Box」（わ
ずかに厚みがあるもの）を選択します。

「Screen Space Refraction」のオーバーライド

屈折を制御する「Transparency Inputs」

Screen Space Refraction

https://unity.com/ja/
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@12.0/manual/Refraction-in-HDRP.html#ScreenSpaceRefraction?utm_source=demand-gen&utm_medium=pdf&utm_campaign=asset-links-gmg-artist-expansion&utm_content=hdrp-guide-ebook
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@12.0/manual/Refraction-in-HDRP.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=asset-links-gmg-artist-expansion&utm_content=hdrp-guide-ebook
https://en.wikipedia.org/wiki/Refractive_index
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ポストプロセス
最新のハイエンドグラフィックスにおいては、ポストプロセスを行わずして完成する
ことはないとも言えます。必ずしもプロセッシングで問題を修正できるわけではあり
ませんが、シネマティックな効果を高めるフィルターやフルスクリーンのイメージエ
フェクトを使用せずに画像をレンダリングすることは、ほとんど考えられません。そ
のため、HDRP には組み込みのポストプロセスエフェクトがバンドルされています。

HDRP のプロセッシングでは、ボリュームシステムを使用してイメージエフェクトを
カメラに適用します。オーバーライドを追加する方法を理解すれば、ポストエフェク
トを適用するプロセスも理解しやすくなるはずです。

ポストプロセスエフェクトを使用すると、よりシネマティックなレンダリングが可能になります。

https://unity.com/ja/
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「Post-processing（ポストプロセス）」でのオーバーライド

色やコントラストを制御するこうした「Post-processing」のオーバーライドの多く
は、機能が重複しています。適切な組み合わせを見つけるためには、ある程度の試行
錯誤が必要です。

すべてのエフェクトを利用する必要はありません。目標とするビジュアルを生み出す
ために必要なオーバーライドのみを追加し、その他は無視します。

使用例については、SampleScene のボリュームをご覧ください。

トーンマッピング

トーンマッピングとは、ハイダイナミックレンジの色を、使用する画面の狭いダイナ
ミックレンジにマッピングする手法です。レンダリングでのコントラストやディテー
ルを改善できます。

「Post-processing（ポストプロセス）」のオーバーライド

「ACES」と「Neutral」のトーンマッピングの比較

https://unity.com/ja/
https://en.wikipedia.org/wiki/High-dynamic-range_imaging
https://en.wikipedia.org/wiki/Dynamic_range
https://en.wikipedia.org/wiki/Dynamic_range
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ビジュアルをフィルム調にしたい場合は、「Mode」を業界標準の「ACES」
（Academy Color Encoding System）に設定します。彩度やコントラストを落と
す場合は、「Neutral」を選択します。経験豊富なユーザーであれば、「Custom」
を選択し、トーンマッピング曲線を自分で定義することもできます。

Shadows、Midtones、Highlights

「Shadows、Midtones、Highlights」のオーバーライドでは、レンダリング対象のシャ
ドウ、中間調、ハイライトそれぞれの色調と色の範囲を制御できます。それぞれのト
ラックボールを使用して、画像内のそれぞれの特性を調整できます。その後、色補正
をクリップまたはプッシュしすぎないように、「Shadow」と「Highlight Limits」を
使用します。

カスタム曲線を使用したトーンマッピング

Shadows, Midtones, Highlights

https://unity.com/ja/
https://en.wikipedia.org/wiki/Academy_Color_Encoding_System
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Bloom

「Bloom」では、光源の周囲に発生する光のにじみのエフェクトを生成できます。こ
れにより、強烈に輝く、まばゆい光の印象を生み出すことができます。

「Intensity」と「Scatter」を設定することで、ブルームのサイズと明度を調整します。
「Lens Dirt」は、ブルームエフェクトを散乱させる汚れやちりのテクスチャーを適用
します。

「Bloom」のオーバーライド

ブルームのエフェクト

https://unity.com/ja/
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Depth of Field

「Depth of Field」は、実際のカメラレンズの被写界深度のシミュレーションを行い
ます。カメラの被写界深度より近い、または遠いオブジェクトは、ぼやけて見えます。

「Depth of Field」が有効な場合は、ぼけと呼ばれるフォーカス外のぼかしエフェク
トが、画像の明るいエリアを中心に現れます。カメラの開口形状を調整し、ぼけの見
え方を変えることができます（前述の「Physical Camera」のその他のパラメーター
を参照）。

「Depth of Field」のオーバーライド

「Depth of Field」では、実際のカメラの被写界深度のシミュレーションを行います。

https://unity.com/ja/
https://en.wikipedia.org/wiki/Bokeh
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White Balance

「White Balance」のオーバーライドを使用すると、最終的な画像で白色が適切にレン
ダリングされるようにシーンの色を調整できます。「Temperature」で、黄色（暖色）
と青（寒色）の間を調整することもできます。「Tint」では、緑とマゼンタの間で色か
ぶりを調整します。

この HDRP サンプルプロジェクトでは、各部屋のローカルボリュームに「White 
Balance」のオーバーライドが含まれています。

Color Curves（カラーカーブ）

グレーディングカーブを使用して、色相、彩度、明るさの特定の範囲を調整できます。
8 つのグラフのいずれかを選択し、色とコントラストをリマップします。

Color Adjustments

このエフェクトを使用して、最終的にレンダリングされる画像の全体的なトーン、明
度、色相、コントラストを調整します。

White Balance

Color Curves

Color Adjustments

https://unity.com/ja/
https://en.wikipedia.org/wiki/Curve_(tonality)
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Channel Mixer

「Channel Mixer」では、カラーチャンネルの「組み合わせ」に、さらに別のカラーチャ
ンネルを適用できます。RGB 出力を選択してから、いずれかの入力の影響度を調整
します。たとえば、「Red Output Channel」で「Green」の影響度を上げると、画像
内のすべての緑色の部分が赤みがかって表示されます。

Lens Distortion

「Lens Distortion」では、現実世界のレンズの製造過程で発生する歪みによって生じ
る放射パターンのシミュレーションを行います。これを設定すると、特にズームレン
ズや広角レンズを使用したときに、直線がわずかに曲がって見えます。

 

Channel Mixer

「Lens Distortion」を使用すると、放射パターンの歪みを画像に適用します。

https://unity.com/ja/
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Vignette

「Vignette」では現実世界の写真に生じる効果を再現し、画像の端部の明度や彩度を
下げます。この現象は、広角レンズを使用した場合や、レンズフードや重ね付けした
フィルターリングによって光が遮られた場合に発生することがあります。見る人の視
線を画面中央に集めるために、このエフェクトが使用されることもあります。

Motion Blur

現実世界では、カメラの露出時間よりも速く移動する物体を撮影すると、線状になっ
たりぼやけたりした状態で写ります。「Motion Blur」のオーバライドで、このような
効果のシミュレーションを行うことができます。

パフォーマンスコストを最小限に抑えるためには、「Sample Count」を減らして
「Minimum Velocity」を上げ、「Maximum Velocity」を下げます。「Additional 
Properties」で「Camera Clamp Mode」のパラメーターを下げることもできます。

「Vignette」を使用すると、フレームの端部が暗くなります。

https://unity.com/ja/
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Rendering Debugger
「Rendering Debugger」ウィンドウ（「Window > Analysis > Rendering Debugger」）
には、スクリプタブルレンダーパイプライン用のデバッグツールと可視化ツールがあ
ります。左側はカテゴリ別に分類されています。各パネルでは、ライティング、マテ
リアル、ボリューム、カメラなどの問題を分割できます。

このデバッガーは、特定のレンダリングパスのトラブルシューティングに役立ちま
す。「Lighting」パネルで「Fullscreen Debug Mode」と入力し、デバッグ機能を
選択できます。

Rendering Debugger

「Fullscreen Debug Mode」オプション

https://unity.com/ja/
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デバッグモードでは、さまざまな情報を手掛かりにして、ライティングやシェーディング
の問題の原因を具体的に突き止めることができます。左側のパネルには、カメラ、マテリ
アル、ボリュームなどの重要な統計情報が表示されており、レンダリングの最適化に役立
てることができます。

フルスクリーンのデバッグモードが有効な場合、シーンビューとゲームビューが切り替わ
り、特定の機能が一時的に可視化されます。この機能を利用して、効率的に診断を進める
ことができます。

「Lighting Debug Mode」と「Fullscreen Debug Mode」は、シーン内の光源を把握するのに有効です。

https://unity.com/ja/


76/83 | unity.com© 2021 Unity Technologies

一般的なマテリアルプロパティーのデバッグを行うこともできます。「Material」ス
クリーンで、「Common Material Properties」の中から、「Albedo」、「Normal」、
「Smoothness」、「Specular」などを選択します。

 

詳細については、レンダーパイプラインデバッガーに関するドキュメントをご覧くだ
さい。

Common Material Properties（マテリアルの基本プロパティ）

レンダーパイプラインデバッガーを使用すると、マテリアルのトラブルシューティングを行えます。

https://unity.com/ja/
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@12.0/manual/Render-Pipeline-Debug-Window.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=asset-links-gmg-artist-expansion&utm_content=hdrp-guide-ebook
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「Render Pipeline Wizard」でレイトレーシングを有効にします。

レイトレーシング
レイトレーシングは、従来のラスタライゼーションよりも訴求力のあるレンダリング
を生成できる手法です。従来は計算コストが大きい処理でしたが、近年のハードウェ
アアクセラレーションの発達により、レイトレーシングのリアルタイム利用が可能に
なりました。

HDRP は、一部の GPU ハードウェアと DirectX 12 API でのレイトレーシングのプレ
ビュー版に対応しています。システム要件の一覧については、「Getting started with 
ray tracing（英語）」を参照してください。

設定

レイトレーシング（プレビュー版）を有効にするためには、HDRP プロジェクトのデ
フォルトのグラフィックス API を DirectX 12 に変更する必要があります。

「Render Pipeline Wizard」（「Window > Render Pipeline > HD Render Pipeline 
Wizard」）2 を開き、「HDRP + DXR」タブで「Fix All」をクリックしてから、エディ
ターを再起動します。パイプラインウィザードのプロンプトに従い、無効になって
いる機能を有効にします。

2 Unity 2021 では、「HDRP Wizard」は「Window > Rendering > HDRP Wizard」にあります

https://unity.com/ja/
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@12.0/manual/Ray-Tracing-Getting-Started.html
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@12.0/manual/Ray-Tracing-Getting-Started.html
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レイトレーシングを手動で設定することもできます。

プロジェクトでレイトレーシングを有効にしたら、「HDRP Global」または「Camera 
Frame Settings」でもレイトレーシングが有効になっていることを確認します。
「Build Settings」で、互換性のある 64 ビットアーキテクチャーを使用しているこ
とを確認します。また、「Edit > Rendering > Check Scene Content for HDRP Ray 
Tracing」から、シーンのオブジェクトを検証します。

オーバーライド

レイトレーシングの導入により、新しい Volume オーバーライドがいくつか追加され、
HDRP の既存のオーバーライドが多数強化されています。

— アンビエントオクルージョン：スク
リーンスペースアンビエントオク
ルージョンに代わって、レイトレー
シングアンビエントオクルージョン
が導入されます。スクリーンスペー
スアンビエントオクルージョンと異
なり、レイトレーシングアンビエン
トオクルージョンでは、画面外のジ
オメトリを使用してオクルージョン
を生成できます。これにより、フレー
ムの端に向かうにつれてエフェクト
が消えたり、不正確になったりする
問題が解消されます。

—  ライトクラスター：レイトレーシン
グでは、シーンが 3D セルのグリッ
ドに分割されます。HDRP では、こ
うしたライトクラスターを基に、光
線がサーフェスに当たったときの局
所的ライティングを判別します。そ
の後、特定のエフェクトの反射光を
計算します（レイトレーシングリフ
レクション、レイトレーシンググロー
バルイルミネーションなど）。

指示に従って無効になっている機能を修正します。

スクリーンスペースリフレクション とレイトレーシン
グアンビエントオクルージョン

https://unity.com/ja/
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@12.0/manual/Ray-Tracing-Getting-Started.html#ManualSetup?utm_source=demand-gen&utm_medium=pdf&utm_campaign=asset-links-gmg-artist-expansion&utm_content=hdrp-guide-ebook
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 「HDRP Debug」モードを使用すると、診断の一環としてライトクラスターを
可視化できます。赤でハイライトされているライトクラスターは、ライト数が 
HDRP アセットの「Maximum Lights per Cell」に達していることを意味しま
す。この設定を調整することで、不要なライトの漏れやアーティファクトを減
らすことができます。

— グローバルイルミネーション：スクリーンスペースイルミネーションとライ
トプローブに代わる機能で、間接的な反射光のシミュレーションを行います。 
レイトレーシンググローバルイルミネーションの計算はリアルタイムで実行さ
れます。オフラインでのライトマップのベイキングプロセスに長い時間をかけ
なくても、同等の結果を実現できます。

 
複数の反射やサンプルからメリットを得られる複雑な屋内環境には、「Quality」
設定を使用します。「Performance」モード（1 つのサンプルと 1 つの反射に限
定）は、ライティングのほとんどがメインのディレクショナルライトによって
行われる屋外の状況に適しています。

デバッグモードでのレイトレーシングライトクラスター

レイトレーシングされたグローバルイルミネーションによって、反射光がリアルタイムで表示されます。

https://unity.com/ja/


80/83 | unity.com© 2021 Unity Technologies

— リフレクション：レイトレーシングリフレクション
では、リフレクションプローブやスクリーンスペー
スリフレクションよりも質の高いリフレクションを
再現できます。画面外のメッシュは、生成されたリ
フレクションで適切に表示されます。

 
「Minimum Smoothness」と「Smoothness Fade 
Start」の値を調整すると、滑らかなサーフェスが
レイトレーシングリフレクションを受ける、しきい
値を変更できます。必要に応じて「Bounces」を
増やすこともできますが（合わせ鏡のような場合）、
パフォーマンスコストに注意してください。

レイトレーシングされたリフレクションが、滑らかな鏡のような面にレンダリングされてい
ます。

レイトレーシングシャドウはキャスターから離れるにつれてぼやけるため、シャドウマッピン
グとは異なる効果が得られます。

— シャドウ：ディレクショナル、ポイント、スポット、
矩形エリアの各ライトのレイトレーシングシャドウ
を、不透明なゲームオブジェクトのシャドウマップ
の代わりに使用することができます。ディレクショ
ナルライトを使用して、透明または半透明のゲーム
オブジェクトからレイトレーシングシャドウを投影
することもできます。

 
レイトレーシングでは、キャスターとの距離が離
れるほどシャドウの輪郭がぼやける「Percentage-
Closer Soft Shadows」（PCSS）を利用できます。
これを利用すると、非常に自然なシャドウを生成で
きます。

 
HDRP のディレクショナルライトでも、半透明の色
付きシャドウを生成できます。この例では、ガラス
のサーフェスによって、リアルな色合いのシャドウ
が床にキャストされています。

— HD レンダーパイプラインのレイトレーシング（プ
レビュー版）のウォークスルーについては、HDRP 
によるレイトレーシングの有効化に関する動画をご
覧ください。詳しくは、HDRP のマイクロサイトで
レイトレーシングに関するドキュメントをご覧くだ
さい。A

https://unity.com/ja/
https://developer.download.nvidia.com/shaderlibrary/docs/shadow_PCSS.pdf
https://developer.download.nvidia.com/shaderlibrary/docs/shadow_PCSS.pdf
https://www.youtube.com/watch?v=ad9f_nKU0ZA
https://www.youtube.com/watch?v=ad9f_nKU0ZA
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@12.0/manual/Ray-Tracing-Getting-Started.html
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その他のリソース

— HDRP の機能に関する概要動画については、このガイドと合わせて、HDRP で
高品質なグラフィックスを作成する方法をご覧いただくことをおすすめします。

— ビルトインレンダーパイプラインから移行する場合は、こちらのチャートをご
覧ください。2 つのレンダーパイプラインの機能の違いが詳細にまとめられて
います。

— HDRP に関するドキュメントには、このパイプラインのあらゆる機能の詳細が
含まれています。

https://unity.com/ja/
https://www.youtube.com/watch?v=yqCHiZrgKzs&t=129s
https://www.youtube.com/watch?v=yqCHiZrgKzs&t=129s
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@12.0/manual/Feature-Comparison.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=asset-links-gmg-artist-expansion&utm_content=hdrp-guide-ebook
https://docs.unity3d.com/Packages/com.unity.render-pipelines.high-definition@12.0/manual/index.html?utm_source=demand-gen&utm_medium=pdf&utm_campaign=asset-links-gmg-artist-expansion&utm_content=hdrp-guide-ebook
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さらに先へ：
このガイドがきっかけとなり、読み終えたあなたには次なるプロジェ
クトで HDRP へぜひ取り組んでいただければと思っています。

もっと高みをめざすあなたには、「3D Sample Project」を Unity Hub から手に入れ
ることができます。リストの下部に記載されているその他のリソースなども、チェッ
クするのをお忘れなく。また、Unity ブログや HDRP コミュニティフォーラムにおい
ては、常に新たな知見を得ることができます。
 
Unity は最先端のコンテンツを作成するのに最適のツールを配備し、アーティストや
開発者の皆様を強く支援したいと常に思っております。ライティングは芸術であり、
科学です。芸術と科学を融合させることで、魔法のような効果が生まれます。

https://unity.com/ja/
https://blog.unity.com/?utm_source=demand-gen&utm_medium=pdf&utm_campaign=asset-links-gmg-artist-expansion&utm_content=hdrp-guide-ebook
https://forum.unity.com/forums/high-definition-render-pipeline.386/?utm_source=demand-gen&utm_medium=pdf&utm_campaign=asset-links-gmg-artist-expansion&utm_content=hdrp-guide-ebook
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